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About This Guide

Purpose
This guide is designed to help you quickly learn to perform high resolution melting
(HRM) analysis using MeltDoctor"" HRM Reagents and High Resolution Melt
Software v3.0. This guide provides step-by-step procedures on:
+ How to calibrate the StepOnePlus™ Real-Time PCR System, StepOne"™
Real-Time PCR System, or 7500 Fast Real-Time PCR System to use the
MeltDoctor™ HRM Dye
+ How to perform a general HRM experiment using the MeltDoctor” HRM Positive
Control Kit
*  How to perform HRM genotyping, HRM mutation scanning, and HRM
methylation studies using MeltDoctor"” HRM Reagents and High Resolution Melt
Software v3.0: How to design the experiment, prepare the reactions, run the
reactions, and review the HRM data
For more information on HRM, go to www.appliedbiosystems.com/hrm.
Prerequisites

This guide assumes that you have working knowledge of the:
+  Microsoft® Windows® XP operating system
* Instrument system software for your real-time PCR system:
— StepOne™ Software v2.2 or later for the StepOne and StepOnePlus systems
— 7500 Software v2.0 or later for the 7500 Fast System

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide 7



About This Guide
Safety information

Safety information

Safety alert words

SDSs

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below:

IMPORTANT! — Indicates information that is necessary for proper instrument
operation or accurate chemistry kit use.

CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

é WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

é DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the most
extreme situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol.

The Safety Data Sheets (SDSs) for any chemicals supplied by Applied Biosystems or
Ambion are available to you free 24 hours a day. For instructions on obtaining SDSs,
see “SDSs” on page 101.

IMPORTANT! For the SDSs of chemicals not distributed by Applied Biosystems,
contact the chemical manufacturer.

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide



Chapter 1

Calibrate the Instrument

The first time that you perform high resolution melting experiments, you must
calibrate your instrument for the HRM dye that you plan to use. Life Technologies
recommends that you calibrate each instrument for each HRM dye that you are using or
for each significant change in master mix composition.

This chapter describes how to calibrate a StepOnePlus™ Real-Time PCR System,
StepOne™ Real-Time PCR System, or 7500 Fast Real-Time PCR System for the
MeltDoctor™ HRM Dye. To use a different HRM dye, see page 89 for instructions and
guidelines.

IMPORTANT! Amplify the DNA, calibrate the instrument, and perform a melt curve to
generate the HRM calibration file on the same day.

Perform a background calibration

1.Prepare the background calibration plate (page 10)
2.Run the background calibration plate (page 10)
3.Review the background calibration results (page 10)

3

Amplify the DNA in the HRM calibration plate

4.Prepare the MeltDoctor™ HRM Calibration Plate (page 11)
5.Run the HRM calibration plate to amplify the DNA (page 11)
6.Verify that the HRM calibration samples amplified (page 13)

Calibrate the instrument to use the MeltDoctor™ HRM Dye

7.Run the HRM calibration plate for the custom dye calibration (page 13)
8.Review the custom dye calibration results (page 14)

3

Perform a melt curve to generate the HRM calibration file

9.Run the HRM calibration plate for the HRM calibration (page 14)
10.Verify that the Melt Curve contains only one Tm peak (page 16)

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide 9



-1 Chapter 1 Calibrate the Instrument
Perform a background calibration

Perform a background calibration

IMPORTANT! Before you can run the HRM dye calibration plate on your instrument,
you must perform a background calibration. The background calibration ensures

that the background signal is even across the reaction plate and that variation is at

a minimum.

Required materials * Appropriate reaction plate for your reaction block:
for b(a:gﬁg:g,t’igg — MicroAmp® Fast Optical 96-Well Reaction Plate with Barcode, 0.1 mL
—  MicroAmp® Fast Optical 48-Well Reaction Plate
+  MicroAmp® Optical Adhesive Film
* Deionized water
* Pipettors and pipette tips
* Centrifuge

Prepare the 1. Add 20 pL deionized water into each well of the reaction plate.
background

calibration plate 2, Sea] the reaction plate with optical adhesive film, then spin the plate.

Run the 1. In the instrument software, select Instrument » Instrument Maintenance

_background Manager, then in the navigation pane, select Background.
calibration plate

2. Click Start Calibration, then follow the instructions in the Setup screen using the
background calibration plate you prepared above.

3. Inthe Run screen, click START RUN.
When the run is complete, the Analysis screen is automatically displayed.

Review the 1. Inthe Analysis screen, verify that the background calibration passed.
background
calibration results
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25000.0

20000.0
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15000.0

10000.0

5000.0
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Chapter 1 Calibrate the Instrument -I
Amplify the DNA in the HRM calibration plate

2. Finish the background calibration and close the Instrument Maintenance Manager.
The software saves the background calibration file.

3. Unload the background calibration plate.

Note: If the background calibration failed, refer to the procedures for cleaning the
sample block in your instrument guide. The background calibration must pass before
you can perform a custom dye calibration.

Amplify the DNA in the HRM calibration plate

Required materials » Appropriate calibration plate for your reaction block:
for HRM calibration — MeltDoctor"™ HRM Calibration Plate, Fast 96-Well
— Prepare your own 48-well HRM calibration plate
* Centrifuge

Note: To prepare your own HRM calibration plate using the MeltDoctor” HRM
Master Mix and MeltDoctor™ HRM Calibration Standard, follow the procedure in
Appendix B on page 90.

PrepTaMre the 1. Remove the Fast 96-Well MeltDoctor'” HRM Calibration Plate from the freezer,
MeltDoctor ® HRM then allow it to thaw.
Calibration Plate

2. Spin the plate briefly.

Run the HRM 1. In the instrument software, create a new experiment for the amplification:
calibration plate to . . B o e ,
amplify the DNA Experiment Name — Use the convention: Amplification_<today’s date>
* Experiment type — Quantitation - Standard Curve
+ Reagents — SYBR® Green Reagents

* Ramp speed — Standard (~ 2 hours to complete a run)

2. In the Plate Setup » Define Targets and Samples tab, define the calibration target
as Target 1 for the target name and SYBR for the reporter.

Define Targets

| Add New Target | Add Saved Target Save Target | Delete Target ‘

Target Name Reporter Quencher Color

[Target ||svar w ||Mons - l:l -

3. In the Plate Setup » Assign Targets and Samples tab, assign the Target 1 target to
the wells in the plate grid:

a. Select all the wells in the plate grid.

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide 11



-1 Chapter 1 Calibrate the Instrument
Amplify the DNA in the HRM calibration plate

b. Select the Assign checkbox for Target 1, then select m (Unknown) as

the Task.
Assign Target Task Quantity
vl Target 1 |E”|]”|]|

c. Select None as the passive reference.

Select the dye to use as the passive reference.

INone 'l

4. In the Setup » Run Method tab, set the thermal cycler conditions:
* Reaction Volume Per Well: 20 pL
» Thermal profile:

Stage Step Temp Time

Holding Enzyme activation 95°C | 10 min
Cycling (40 cycles) Denature 95°C | 15sec
Anneal/extend 60 °C 1 min

5. Load the HRM calibration plate into the instrument, then start the run.

6. At the prompt, save the amplification file:
* Location: Create a folder called HRMCalibrationFiles.
* File name: Use the convention Amplification_<today’s date>
When the run is complete, the Analysis screen is automatically displayed.

7. Unload the HRM calibration plate.

12 HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide



Chapter 1 Calibrate the Instrument -1
Calibrate the instrument to use the MeltDoctor™ HRM Dye

Verify that the HRM 1. Review the Amplification Plot for normal characteristics:
calibration samples .
amplified Fluorescence levels that exceed the threshold between cycles 8 and 35

* An exponential increase in fluorescence
» Standard deviation of C; values <0.25.
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Note: If the Amplification Plot looks abnormal, contact an Applied Biosystems
representative to identify and resolve the problem.

2. Save and close the file.

Calibrate the instrument to use the MeltDoctor™ HRM Dye

Perform a custom dye calibration for the MeltDoctor” HRM Dye using the same HRM
calibration plate that you amplified on page 11.

Run the HRM 1. In the instrument software, select Instrument » Instrument Maintenance

calibration plate for Manager, then in the navigation pane, select Custom Dye Calibration.
the custom dye

calibration 2. Click Start Calibration, then follow the instructions in the Setup screen:

a. In step 1, for the custom dye calibration plate, use the amplified HRM
calibration plate.

b. Add the HRM dye to the Dye Library: Click New Dye, then enter
MeltDoctor for the name, select Reporter as the dye type, and click OK.

Mame: |MeItDoct0r

Wavelength (Optional):l |nm LI
Type
' Reporter

 Quencher

 Both
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-1 Chapter 1 Calibrate the Instrument
Perform a melt curve to generate the HRM calibration file

c. In step 2, select MeltDoctor as the Dye Name.

2. Select a dye or create a new dye:

Dye Mame: |MeltDoctor  + || NewDye |

d. In step 3, set the temperature to 60 °C (default).

3. Set the data collection temperature:

Temperature: 60.0|°C

e. Spin the HRM calibration plate briefly, load the plate into the instrument,
select the checkbox The custom dye plate is loaded into the instrument,
then click Next.

3. In the Run screen, click START RUN.

4. When the run is complete, unload the HRM calibration plate, then click Next to
view the Analysis screen.

Review the custom 1. In the Analysis screen, verify that the custom dye calibration passed.
dye calibration

results Note: If the custom dye calibration failed, refer to your instrument guide. You
cannot complete the HRM calibration until the custom dye calibration passes.

2. Finish the custom dye calibration and close the Instrument Maintenance Manager.
The software saves the custom dye calibration file.

Perform a melt curve to generate the HRM calibration file

Use the HRM calibration plate a third time to perform a melt curve and generate an
HRM calibration file for the HRM Software.

Run the HRM 1. In the instrument software, create a new experiment for the HRM calibration:
calibration plate for

the HRM calibration » Experiment Name — Use the convention

HRMCalibration_MeltDoctorDye_<instrument info>_<today’s date>
» Experiment type — Melt Curve
* Reagents — Other
* Ramp speed — Fast

2. In the Plate Setup » Define Targets and Samples tab, define the calibration target
as Target 1 for the target name and MeltDoctor for the reporter.

3. In the Plate Setup » Assign Targets and Samples tab, assign Target 1 to the wells
in the plate grid:

a. Select all the wells in the plate grid.
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Chapter 1

Calibrate the Instrument -1
Perform a melt curve to generate the HRM calibration file

b. Select the Assign checkbox for Target 1, then select m (Unknown) as

the Task.
Assign Target Task Quantity
vl Target 1 ||||]||D|

c. Select None as the passive reference.

Select the dye to use as the passive reference.

INone 'l

4. Set the thermal cycler protocol in the Instrument » Thermal Profile tab:
» Reaction Volume Per Well — 20 pL

» Thermal profile:

Stage Step Temp Time

Melt curve Denature 95°C  10sec
Anneal 60 °C 1 min

High resolution melt 95°C | 15sec

Anneal 60°C | 15sec

+ Ramp mode and rate (StepOne™ and StepOnePlus™ systems) — Select the

Continuous ramp mode, then set the ramp rate to 0.3%.

* Expert Mode (7500 system) — Select the Expert Mode checkbox.
* Filters (7500 system) — Click Select/View Filters, then select only Filter-1.

5. Spin the HRM calibration plate briefly, load the plate into the instrument, then

start the run.

6. At the prompt, save the HRM calibration file:
* Location: HRMCalibrationFiles folder that you created when you ran the

HRM calibration plate to amplify the DNA (see page 11).

* File name: Use the convention:
HRMCalibration_MeltDoctorDye_<instrument info>_<today’s date>

IMPORTANT! Make sure you include instrument information (instrument
model number, plate type, and software version) in the file name so you can
easily verify that the HRM calibration file is appropriate to assign to the
HRM experiment file. If you have multiple instruments, include information
to identify the instrument (for example, an instrument name).

When the run is complete, the Analysis screen is automatically displayed.

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide
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Chapter 1 Calibrate the Instrument
Perform a melt curve to generate the HRM calibration file

Verify that the Melt
Curve contains only

16

one Tm peak

1.

Verify that the Melt Curve contains only 1 Tm peak, as in the example below.

1800000 0

13000000

Derivative Reporter (-Fn)

Note: If the Melt Curve contains more than 1 Tm Peak, more than one PCR
product was produced. Contact an Applied Biosystems representative to identify
and resolve the problem.

Save and close the file, then unload the HRM dye calibration plate.

IMPORTANT! When you open an experiment file in the HRM Software for the
first time, you will be prompted to select the default HRM calibration file. Select
the file that you created using the convention:
HRMCalibration_MeltDoctorDye_<instrumentinfo>_<today’s date>.

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide



Chapter 2

Perform an HRM Experiment

Use MeltDoctor" HRM Reagents and High Resolution Melt Software v3.0 to generate
and analyze high-resolution melting curves from HRM reactions run on your
StepOne™, StepOnePlus™, or 7500 Fast Real-Time PCR System.

This chapter provides general instructions for performing an HRM experiment, using
the MeltDoctor" HRM Positive Control Kit as an example.

Perform an HRM Experiment

Design the HRM experiment (below)

Prepare the HRM reactions (page 18)

Amplify and melt the DNA (page 21)

Review the high-resolution melting data (page 25)

Design the HRM experiment

Design and order
the primers

Using Primer Express® Software v3.0 or later, design the primers to amplify the
sequence of interest. Order the primers from the Applied Biosystems Store.

If you are using the MeltDoctor” HRM Positive Control Kit, the kit contains primers
designed to amplify the alleles in the positive control DNA. You do not need to design
primers to use the Positive Control Kit.

1. Design the primers so that they meet these guidelines:

Design attribute

Design guidelines

Amplicon

Length is less than 250 basepairs

Primer length
Tm
% GC content

~20 bases each
58 °C to 60 °C (Optimal Tm is 59 °C)
30-80% GC content in each primer

3’ end

Repeating
oligonucleotides

No more than 2 G+C residues in the last 5 nucleotides
at the 3’ end

Avoid consecutive identical nucleotides. If you are
unable to avoid consecutive identical nucleotides,
make sure that each primer contains fewer than 4
consecutive Gs.

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide
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2 Chapter 2 Perform an HRM Experiment
Prepare the HRM reactions

2. Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user. For more instructions, see
“Order custom primers” on page 92.

Plan to use controls  Include controls for each target sequence in your HRM experiment:

* At least one negative control

» At least one positive control to represent each expected variant (for genotyping
experiments)

Run 3 to 5 replicates for each expected variant to improve your results. Running
multiple positive controls allows you to more effectively define the natural spread
or variation within different samples of the same sequence, or within replicates of
the same genotype.

» At least one wild type control (for mutation scanning experiments)
Run up to 5 replicates for each wild type control to improve your results. Running
multiple wild type controls allows you to more effectively define the natural
spread or variation within the normal population.

Prepare the HRM reactions

Combine purified genomic DNA templates with MeltDoctor”” HRM Master Mix and
primers to amplify the target sequence.

With the MeltDoctor”™ HRM Positive Control Kit, combine positive control Allele
DNA with the MeltDoctor" HRM Master Mix and MeltDoctor” HRM Primer Mix to
amplify the alleles.

Note: If you are using the MeltDoctor’" HRM Reagents instead of the MeltDoctor™™
HRM Master Mix, see page 93 for reaction component volumes.

18 HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide
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Chapter 2 Perform an HRM Experiment 2
Prepare the HRM reactions

Required materials * Microcentrifuge tubes
» Optical reaction plate appropriate for your Real-Time PCR instrument
+  MicroAmp® Optical Adhesive Film

+ For the example experiment using the MeltDoctor™ HRM Positive Control Kit,
components from the kit:

—  MeltDoctor™ HRM Primer Mix (20X)
— MeltDoctor™ HRM Allele A DNA (20X)
— MeltDoctor™ HRM Allele G DNA (20X)
— MeltDoctor™ HRM Allele A/G DNA (20X)

* For your own HRM experiments:
— Forward and reverse primers (5 uM each)
— DNA samples

+ MeltDoctor HRM Master Mix

* Deionized water

* Pipettors and pipette tips

* Vortexer

» Centrifuge

Prepare the HRM  Prepare the reactions for each replicate group separately, then transfer the reactions to a
reactions  reaction plate appropriate for your instrument.

To prepare HRM reactions for your own HRM experiments:

HRM experiment type See page
HRM genotyping experiments page 37
HRM mutation scanning experiments page 50
HRM methylation studies page 66

For information about using the MeltDoctor"” HRM Reagents to optimize your
reactions, see “Optimizing the reaction conditions” on page 93.

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide 19
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Chapter 2 Perform an HRM Experiment

Prepare the HRM reactions

1.

Prepare the negative control reactions in an appropriately sized, labeled tube:

Volume for

Volume for three 20-pL

Components one 20-pL replicates

reaction plus 10%
excess
MeltDoctor™ HRM Master Mix 10 pL 33.0 uL
MeltDoctor™ HRM Primer Mix 1pL 3.3 L

(20X)

Deionized water 9 uL 29.7 uL
Total volume 20 pL 66 pL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. We recommend an excess

volume of at least 10%.

Prepare the reactions using the Positive Control Kit in separate appropriately

sized, labeled tubes:

Volume for
Volume for three 20-pL
Components one 20-pL replicates
reaction plus 10%
excess
MeltDoctor™ HRM Master Mix 10 pL 33.0 L
One type of allele DNA: 1L 3.3 L
¢ MeltDoctor™ HRM Allele A
DNA (20X)
¢ MeltDoctor™ HRM Allele G
DNA (20X)
¢ MeltDoctor™ HRM Allele A/G
DNA (20X)
MeltDoctor™ HRM Primer Mix 1L 3.3 uL
(20X)
Deionized water 8 uL 26.4 yL
Total volume 20 uL 66 pL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. We recommend an excess

volume of at least 10%.

3. Vortex the reactions to mix, then spin the tubes briefly.

4. Prepare a reaction plate appropriate for your instrument:

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide
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Chapter 2 Perform an HRM Experiment 2
Amplify and melt the DNA

b. Seal the reaction plate with optical adhesive film, then spin the reaction plate.

c. Confirm that the liquid is at the bottom of the wells in the reaction plate.

Note: If you plan to wait more than 24 hours before running the plate, store the
plate at 4 °C. Allow the plate to warm to room temperature, then spin the plate
briefly before running it.

Amplify and melt the DNA

After you have prepared the reaction plate, run the plate to amplify and melt the DNA
and to generate HRM fluorescence data.

Create and setupa 1. Inthe instrument software, create a new experiment to amplify and melt the DNA,
new experiment file then set up the file in the Experiment Properties screen:
for the HRM run . . .
* Experiment Name — Enter a unique name for your experiment
* Instrument — Select the appropriate instrument type
* Experiment type — Quantitation - Standard Curve
* Reagents — Other, then select the Include Melt Curve checkbox

* Ramp speed — Standard (~ 2 hours to complete a run)

2. Define each target sequence and each sample in the reaction plate in the Plate
Setup » Define Targets and Samples tab:

» For each target sequence in the reaction plate, add a corresponding target to
the experiment: Click the Target Name cell, enter a target name, then select
MeltDoctor from the Reporter dropdown menu.

» For each sample in the reaction plate, add a sample name: Click Add New
Sample, then enter a sample name.

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide 21
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Chapter 2 Perform an HRM Experiment

Amplify and melt the DNA

3. Assign targets and samples to wells in the plate grid to match the layout of your
reaction plate in the Plate Setup » Assign Targets and Samples tab:

Set up the negative controls: Select the negative control wells in the plate
grid, then select the Assign checkbox next to your target and select the
(Negative Control) task.

Note: Negative controls are needed to control for the amplification, but they
are not appropriate for HRM analysis. Make sure you assign the Negative
Control task for negative controls so that the HRM Software will
automatically omit the negative controls from the HRM analysis.

Set up the unknowns: Select the wells containing DNA samples in the plate
grid, then select the Assign checkbox next to your target. The ‘ﬂ Unknown
task is selected by default.

Note: Set up your variant controls as unknowns during experiment setup.
You will set up the variant controls when you set up the analysis using the
HRM Software.

For each sample, select the wells that contain a sample, then select the Assign
checkbox next to the corresponding sample name.

Note: If you are running multiple assays, make sure you define each target
sequence in the plate and assign the targets to the appropriate wells. The HRM
Software will automatically separate the wells into different assays according to
the target assigned to the well.

4. Set the Passive Reference to None.

5. Inthe Run Method screen, set the thermal cycler conditions:

Reaction Volume Per Well: 20 puL

Thermal profile:

Stage Step Temp Time

Holding Enzyme activation 95°C | 10 min
Cycling (40 cycles) Denature 95°C | 15sec
Anneal/extend 60 °C 1 min

Melt curve Denature 95°C | 10sec
Anneal 60 °C 1 min

High resolution melt 95°C | 15sec

Anneal 60°C @ 15sec

Ramp mode and rate (StepOne'” and StepOnePlus™ systems): Select the
Continuous ramp mode, then set the ramp rate to 0.3%.

Expert Mode (7500 system): Select the Expert Mode checkbox.
Filters (7500 system): Click Select/View Filters, then select only Filter-1.

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide



Chapter 2 Perform an HRM Experiment 2
Amplify and melt the DNA
Run the plate to 1.

| In the navigation pane, select Run, then load the reaction plate into the
amplify and melt instrument, then click START RUN.
the DNA

Note: You may receive a message recommending SYBR® Green reagents for melt
curve experiments. Click OK to close the message.

2. At the prompt, save the file to a desired save location.

Verify that the 1. Review the Amplification Plot for normal characteristics:
samples amplified .
and review the Tm Fluorescence levels that exceed the threshold between cycles 8 and 35
peaks .

An exponential increase in fluorescence

10000000
1000000
100000

10000

ARN

1000

100

Note: Note which wells are outliers with C; values that differ from replicates by
more than 2. The outliers may produce erroneous HRM results.

Note: If the Amplification Plot looks abnormal, refer to “Troubleshooting HRM
Experiments” on page 79 to identify and resolve the problem.
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2. Verify that the Melt Curve shows no unexpected Tm peaks:

If the sequence you amplified contains more than 1 variant or a more complex
mutation, you may see more than 1 Tm peak because of the large differences
between the different sequence types.

Note: Unexpected peaks at low temperatures may indicate contamination, primer
dimers, or non-specific amplification.

Note: The data may appear noisy because more data is collected during a high
resolution melt curve than during a standard melt curve. The extra data are
required for analysis with the HRM Software.

3. Save and close the file.
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Review the high-resolution melting data

After you create, run, analyze, and save the *.eds experiment file on your real-time
PCR system, use the High Resolution Melt Software v3.0 (HRM Software) to perform
high resolution melting analysis of the data and review the variants.

Start the software  You can start the HRM Software two ways:

* From the desktop: Double-click ; (HRM Software v3.0 or later)
or
» From the Start menu: Select Start » All

Programs » Applied Biosystems » HRM Software » HRM Software v3.0
(or later)

Access the Help The HRM Software has a Help system that describes how to use each feature of the
system  software. You can access the Help system three ways:

+  From the HRM Software window or dialog box: Click &2.

* From the HRM Software menu: Select Help » High Resolution Melt Software
Help.

* From your keyboard: Press F1.

About the HRM  The HRM calibration file is the *.eds file that you created, ran, and analyzed on your
calibration file  real-time PCR system during the HRM calibration (see Chapter 1, Calibrate the
Instrument). When you analyze an HRM experiment file in the HRM Software, the
software requires an HRM calibration file to assign to the HRM experiment file. The
data from the HRM calibration file are used in the HRM analysis.

HRM calibration file  You need to have an HRM calibration file for each instrument that you are using to run
requirements  the HRM reactions.

IMPORTANT! The HRM calibration file must be:

* Run on the same instrument system (the same instrument and the same software
version) as the run file.

* Generated using the same reagents (HRM dye and master mix) as the reactions in
your HRM experiment plate.

* Run using the same run conditions (the same ramp mode and ramp increment) as
the run file.
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Example HRM
experiments

Open the HRM
experiment

For each instrument type, the first time that you open a file from that instrument type,
the software will prompt you to select a default HRM calibration file to assign to HRM
experiment files from that instrument type. If you have multiple instruments of the
same instrument type, you need to create an HRM calibration file for each instrument,
but you can select only one default HRM calibration file for each instrument type.

Note: The HRM Software can distinguish between calibration files from two different
instrument types but cannot distinguish between two different instruments of the same

type.

One recommendation for managing the HRM calibration file is to select the HRM
calibration file from the most commonly used instrument as your default calibration
file. When you analyze new HRM experiments, consistently verify that the HRM
calibration file and the HRM experiment were run on the same instrument. If the HRM
experiment file was run on a different instrument, change the calibration file.

IMPORTANT! Make sure you include instrument information (instrument name,
instrument model number, plate type, and software version) in the HRM calibration
file name so you can easily verify that the HRM calibration file is appropriate for the
HRM experiment file.

Example HRM experiment files are located in X:\Applied Biosystems\HRM\
Examples, where X is the drive where you installed the HRM Software.

* Genotyping Example-HRM.eds

* Class 4 SNP StepOnePlus Example -HRM.eds

* Low Percent Methylation Titration-HRM.eds

* Mutation Scanning Example

*  Multiple Assay StepOnePlus Example-HRM.eds

To follow the example HRM experiment used in this chapter, use the
Genotyping Example-HRM.eds file.

Note: The example files installed with the software are HRM experiment files and
already have the appropriate HRM calibration files assigned to them.

In the HRM Software, open the *.eds experiment file from your real-time PCR system.

The HRM Software uses the default analysis settings to automatically assign a variant
call to each sample. The software determines the variant calls by melt curve
characteristics — melt curve shapes and Tm values. Before you assign the controls, the
software labels each variant call variantl, variant2, variant3, and so on.

1. Using the HRM Software, select File » Open from the menu bar or click ._j Cpen. .
in the toolbar.

2. Browse to and select the *.eds file to undergo HRM analysis.
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3. Select or check the HRM calibration file:

+ If'this is the first time to open an *.eds file for a particular instrument type,
browse to and select the HRM calibration file to use as the default HRM
calibration file.

+ Ifthe default HRM calibration file was already selected for the instrument
type, go to the Experiment Properties screen and verify that the HRM
calibration file is correct.

IMPORTANT! Use the HRM calibration file name to verify that the HRM

calibration file that is assigned to the HRM experiment is correct. The HRM

calibration file must be:

* Run on the same instrument system (the same instrument, the same block type,
and the same software version) as the run file

* Run using the same HRM dye and master mix used in the HRM calibration
plate

* Run using the same run conditions (the same ramp mode and ramp increment)
as the run file.

Note: To change the HRM calibration file for a selected experiment or to change
the default HRM calibration file for subsequent new HRM experiments, see
page 95.

Assign controls  For each positive control sample, enter information about that control in the HRM
software and assign the control to the appropriate wells.

Note: Negative control samples that were designated as Negative Controls using the
instrument software are automatically omitted from analysis in the HRM Software.

1. Add controls to the experiment in the Controls section of the Define screen:

» To create a new control: Click New in the toolbar above the control table,
then define the control.

* To add one or more controls from the Control Library: Click Add Saved in
the toolbar above the control table, select one or more controls, then click
Add Selected Controls.

2. Assign controls to wells on the Assign screen:

a. Select wells using the plate layout or the well table.

HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide 27



2 Chapter 2 Perform an HRM Experiment
Review the high-resolution melting data

b. In the Controls list, select the checkbox next to the control you want to assign
to the selected wells.

Note: You can assign only 1 control to a well. If the selected wells contain
mixed assignments (indicated by a =), remove existing control assignments
before you make the new control assignment.

Note: After you reanalyze the experiment, the variant call for the controls is named
using the convention Control-<name>, where <name> is the name you entered when
you set up the controls.

About the melting  The melting profile of a PCR product depends on its GC content, length, sequence, and
profiles  heterozygosity. High-resolution melting analysis calls variants based on the differences
in the shape of the melt curves and the differences in the Tm values.

With the MeltDoctor' HRM Positive Control Kit:

* The heterozygotes have a different curve shape compared to the homozygotes.
The shape of the melt curve is an indicator of heteroduplex formation.

* The two homozygotes are distinguished from each other based on the difference in
Tm values.
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About the pre- and  In the Derivative Melt Curves plot and the Raw Melt Curves plot, there are two sets of
post-melt regions  lines before and after the data peak. These lines define the pre-melt and post-melt
regions. The pre- and post-melt regions are used to scale the data in the Aligned Melt
Curves and Difference Plot.

* Pre-melt region: The set of lines to the left of the peak indicate the pre-melt start
and stop temperatures when every amplicon is double-stranded.
Fluorescence data from the pre-melt region correspond to 100% fluorescence.

+ Active melt region: The data peak indicates the active melt region of the plot. For
each sample, the change in fluorescence to the right of the 100% fluorescence
point correspond to the true fluorescence change. Data from the active melt region
are used to plot the Aligned Melt Curves.

Note: In methylation studies, the Derivative Melt Curves plot typically displays
multiple peaks.

* Post-melt region: The set of lines to the right of the peak indicate the post-melt
start and stop temperatures when every amplicon is single-stranded.

Fluorescence data from the post-melt region correspond to 0% fluorescence.

4869
873

Fluorescence

cccccc

ccccccc

Cremperature(-Cy
Pre-melt region
Post-melt region

Specify the analysis  Specify the analysis settings for each assay in the plate:
settings
1. In the navigation pane, select to view the High Resolution Melt Plots screen,
click Analysis Settings (top right corner), then select an assay from the table of
assays on the left.
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2. Specify the settings for the pre-melt and post-melt regions:

» Select the checkbox for the software to automatically set the pre- and post-
melt regions for each well (default setting).

» Deselect the checkbox to manually define the pre- and post-melt regions for
all assay wells:

— Pre-melt region — Pre-melt stop temperature is next to the start of the
melt transition region and pre-melt start temperature is 0.5 to 1 °C lower
than the pre-melt stop temperature.

— Post-melt region — Post-melt start temperature next to the end of the
melt transition region and post-melt stop temperature 0.5 to 1 °C higher
than the pre-melt stop temperature.

3. For the number of variant groups, make sure the checkbox is selected so that the

software will automatically determine the number of variant groups (default
setting).

IMPORTANT! If you assigned controls, you need to select the checkbox for the
software to automatically set the number of variant groups. The algorithms that
assign variant calls according to an entered number of variant groups are
incompatible with the algorithms that assign variant calls according to the controls
that are assigned. If you assign controls and enter the number of variant groups,
you will get unpredictable results.

. Click Apply Analysis Settings to close the analysis settings and reanalyze the

experiment.

. After the reanalysis is complete, save the experiment.

Note: When you save the HRM experiment the first time, “-HRM?” is added to the
file name to indicate that the experiment run file is associated with an HRM
calibration file and contains HRM data. You cannot open an HRM experiment file
using the instrument software. The original experiment run file is maintained.
Keep the “~-HRM” in the HRM experiment file name to distinguish between the

* eds files.

Review and adjust the pre- and post-melt regions to optimize the separation and variant
calls. For most experiments, set the pre- and post-melt regions as close as possible to
the melting transition region.

This procedure describes how to manually adjust the pre- and post-melt regions from
the plot.

. In the plot pane, select the Derivative Melt Curves tab.
2. Press Ctrl+A to select all the wells.

3. Set the pre-melt region:
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a. Move the pre-melt stop and start temperature lines together by clicking the
horizontal line that joins the lines at the top then dragging the lines so that the
pre-melt stop temperature line is next to the start of the melting transition
region.

b. Ifnecessary, click and drag the pre-melt start temperature line approximately
0.2 to 0.5 °C from the pre-melt stop temperature line.

L7900

2 M Click and drag the top bar to move the start and stop
temperatures together

Click and drag one temperature line to move each
temperature individually

Set the pre-melt stop next to the start of the melting transition

Set the pre-melt start ~0.2 to 0.5 °C from the pre-melt stop

Note: The pre-melt region should be within a flat area where there are no large
spikes or slopes in the fluorescence levels.

4. Set the post-melt region:

a. Move the post-melt stop and start temperature lines together by clicking the
horizontal line that joins the lines at the top then dragging the lines so that the
post-melt start temperature line is next to the end of the melting transition
region.
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b. If necessary, click and drag the post-melt stop temperature line
approximately 0.5 to 1 °C from the post-melt start temperature line.

4869
873

Click and drag the top bar to move the start and stop——f———
temperatures together

Click and drag one temperature line to move each— w1
temperature individually

Set the post-melt start next to the end of the melting transition

Set the post-melt stop ~0.5 to 1 °C from the post-melt start

Note: The post-melt region should be within a flat area where there are no large
spikes or slopes in the fluorescence levels.

5. Click Analyze, then save the changes.

The software reanalyzes the data using the new pre- and post-melt regions. In all

of the high resolution melt plots, the color of the melt curves changes to reflect the
new results.

Review the  The Aligned Melt Curves plot displays the melt curves as % melt (0-100%) over
populations in the  temperature. The melt curves are aligned to the same fluorescence level using the

Aligned Melt i el ,
Curves plot P™® and post-melt regions.

1. In the navigation pane, select to view the High Resolution Melt Plots screen,
then select the Aligned Melt Curves tab.

2. Review:

* Variant groups (different colors) — How many different variant groups are

displayed? Does this number correspond to the number of variant groups you
were expecting?

* OQutliers — Are there any curves within a variant group that do not cluster
tightly with the other samples in that group?
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Aligned Melt In the example experiment, there are 3 distinct variant groups, 1 for each genotype.
Curves example  Notice how the curves differ for the variants: The green curves have a different shape,
and the red and blue curves have a similar shape but different Tm.

Review the The Difference Plot displays the aligned data as the difference in fluorescence between
Difference Plot for  the melt curve for a reference sample and the other melt curves. You can select a
outliers  ohtrol or any well as a reference. After you select the reference, the software subtracts
the reference curve from the other curves.

The Difference Plot allows you to more easily see small differences between curves
and identify outliers.

1. In the High Resolution Melt Plots screen, select the Difference Plot tab.

2. From the Reference dropdown menu (above the plot), select a control or any well
as the reference, then review:

* Variant groups — How many distinct clusters are displayed?
* Outliers — How tight are the curves within each variant group?

Note: Try selecting different reference samples to find the optimal display of
the groups.

Difference Plot In the example experiment, there are 3 distinct variant groups, 1 for each genotype. The
example  wild type control (heterozygote) is selected as the reference (blue curves):

Diference
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Review the The HRM Software automatically makes a call for each sample according to the shape
software calls  of the aligned melt curves and the Tm. Review the software calls, then omit outliers or
change calls.

1. In the Results pane, click the Well column header to sort the results according to
the well position.

2. For the positive controls, review:

* Variant Call column — Do all of the positive control replicates have the
correct call?

» Silhouette Score column — Are the silhouette scores close to 1.0 (0.8 to 1.0)?

Note: For wells with low silhouette scores (below 0.8), review the data.

3. For each replicate group, review:
* Variant Call column — Do all replicates have the same call?
+ Silhouette Score column — Are the silhouette scores close to 1.0 (0.8 to 1.0)?

Note: For wells with low silhouette scores (below 0.8), review the data.

4. To view the fluorescence data for certain wells, select the rows in the Results
table.

5. In the Results pane, click the Variant Call column header to sort the results
according to the variant call. For each variant call, review the samples that were
assigned that call.

Omit outliers from  After you review the data, omit outliers from the analysis. You can omit outliers in a
analysis  high resolution melt plot, the plate layout, or the well table.

Note: Try omitting outliers from the Difference Plot, where the variance is easily
visualized.

1. Select the outliers, then omit the wells:

» High resolution melt plot — Click and drag to draw a box around the
outliers, right-click in the box, then select Omit Wells.

* Plate layout — Right-click the wells, then select Omit.

*  Well table — Select one or more wells in the table, right-click, then select
Omit.

2. Click Analyze to omit data from the selected wells and reanalyze the remaining
data.

34 HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide



Chapter 2 Perform an HRM Experiment 2
Review the high-resolution melting data

Change calls made If you do not agree with the call automatically made by the software (Auto call), you
by the software  can manually change the call in a high resolution melt plot or the plate layout.

1. Select samples, then manually change the call:

Location Procedure
High resolution 1. Click and drag to draw a box around the samples, right-click
melt plot in the box, then select Manual Call.

2. To change the call to:

e A call that has already been made for other samples:
Select the appropriate call from the dropdown menu.

e A new call: Select New, enter a name for the new call, then
select a color.

Plate layout 1. Double-click one well.

2. To change the call to:

* A call that has already been made for other samples:
Select the appropriate call from the dropdown menu.

e A new call: Select New custom call, enter a name for the
new call, then select a color.

For each sample that received a manual call, Manual Call appears in the
Comments column.

2. Click Analyze to reanalyze the data using your manual calls.

Revert selected If you want to remove a manual call for selected samples, you can revert the manual

manual calls to the  call to the call automatically made by the software (Auto call).
software Auto call

1. Select samples, then revert the manual call:

Pane Procedure
High resolution Click and drag to draw a box around the samples, right-click in
melt plot the box, then select Auto Call.
Plate layout Double-click one well, then select Auto call from the dropdown
menu.

2. Click Analyze to reanalyze the data using the software Auto call for the selected
samples.

Revert all manual If you want to remove all manual calls for all samples in an assay, you can revert all
calls for an assay  manual calls to the call automatically made by the software.

1. In an Analysis screen, click Analysis Settings (top right corner).
2. Select an assay from the table of assays on the left.

3. Select the Remove manual calls upon reanalysis checkbox, then click Apply
Analysis Settings.

The software reanalyzes the data for all samples in the selected assay.
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Perform an HRM Genotyping Experiment

Perform an HRM genotyping experiment to determine the genotype of a DNA sample.
Perform an HRM Genotyping Experiment

Design the HRM experiment (below)
Prepare the HRM reactions (page 38)
Amplify and melt the DNA (page 40)

Review the high-resolution melting data (page 43)

Design the HRM experiment

Design and order  Using Primer Express® Software v3.0 or later, design the primers to amplify the
the primers  genomic DNA that contains the single nucleotide polymorphism (SNP) of interest.
Order the primers from the Applied Biosystems Store.

1. Design the primers so that they meet these guidelines:

Design attribute Design guidelines

Amplicon e Length is less than 250 basepairs
e Contains only 1 SNP

Primer length ~20 bases each

Tm 58 °C to 60 °C (Optimal Tm is 59 °C)

% GC content 30-80% GC content in each primer

3" end No more than 2 G+C residues in the last 5 nucleotides
at the 3" end

Repeating Avoid consecutive identical nucleotides. If you are

oligonucleotides unable to avoid consecutive identical nucleotides,

make sure that each primer contains fewer than 4
consecutive Gs.

2. Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user. For more instructions, see
“Order custom primers” on page 92.
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Plan to use controls Include controls for each SNP sequence in your HRM genotyping experiment:

At least one negative control

At least one positive control to represent each expected genotype

Run 3 to 5 replicates for each expected genotype to improve your results. Running
multiple positive controls allows you to more effectively define the natural spread
or variation within different samples of the same sequence, or within replicates of
the same genotype.

Prepare the HRM reactions

Combine purified genomic DNA templates with MeltDoctor”” HRM Master Mix and
primers to amplify the target sequence.

Note: If you are using the MeltDoctor’" HRM Reagents instead of the MeltDoctor™™
HRM Master Mix, see page 93 for reaction component volumes.

Required materials .

Microcentrifuge tubes
Optical reaction plate appropriate for your Real-Time PCR instrument
MicroAmp® Optical Adhesive Film
MeltDoctor™ HRM Master Mix
For each target sequence:
— Forward and reverse primers (5 uM each)
— DNA samples
Deionized water
Pipettors and pipette tips
Vortexer
Centrifuge

Prepare the HRM  Prepare the reactions for each replicate group separately, then transfer the reactions to a
reactions  reaction plate appropriate for your instrument.

For information about using the MeltDoctor'” HRM Reagents to optimize your
reactions, see “Optimizing the reaction conditions” on page 93.
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Prepare the HRM reactions

1. Prepare the negative control reactions in an appropriately sized, labeled tube:

Volume for
Volume for three 20-pL
Components one 20-pL replicates
reaction plus
10% excess
MeltDoctor™ HRM Master Mix 10.0 pL 33.00 pL
Primer 1 (5 M) 1.2 L 3.96 pL
Primer 2 (5 uM) 1.2 pL 3.96 L
Deionized water 7.6 uL 25.08 pyL
Total reaction volume 20.0 yL 66.00 pL

IMPORTANT! Include excess volume in your calculations to provide excess

volume for the loss that occurs during reagent transfers. We recommend an excess

volume of at least 10%.

2. Prepare positive control reactions and unknown reactions in separate appropriately

sized, labeled tubes:

Volume for
Volume for three 20-pL
Components one 20-pL replicates
reaction plus 10%
excess
MeltDoctor™ HRM Master Mix 10.0 pL 33.00 pL
Primer 1 (5 uM) 1.2 L 3.96 pL
Primer 2 (5 uM) 1.2 pL 3.96 L
Genomic DNA (20 ng/pL) 1.0 L 3.30 yL
Deionized water 6.6 uL 21.78 pL
Total reaction volume 20 yL 66 pL

IMPORTANT! Include excess volume in your calculations to provide excess

volume for the loss that occurs during reagent transfers. We recommend an excess

volume of at least 10%.

3. Vortex the reactions to mix, then spin the tubes briefly.

4. Prepare a reaction plate appropriate for your instrument:

a. Pipet each reaction replicate to the appropriate wells of the optical reaction

plate.

b. Seal the reaction plate with optical adhesive film, then spin the reaction plate.
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c. Confirm that the liquid is at the bottom of the wells in the reaction plate.

Note: If you plan to wait more than 24 hours before running the plate, store the
plate at 4 °C. Allow the plate to warm to room temperature, then spin the plate
briefly before running it.

Amplify and melt the DNA

After you have prepared the reaction plate, run the plate to amplify and melt the DNA
and to generate HRM fluorescence data. This chapter contains brief instructions. For
detailed instructions, see page 21.

Create and set up a  Using the real-time PCR instrument software, open and set up the HRM experiment

new experiment file  yn file:
for the HRM run

Setup Setting
Experim_ent Experiment type: Quantitation - Standard Curve
properties Reagents: Other, then select the Include Melt Curve checkbox
Ramp speed: Standard (~ 2 hours to complete a run)
Targe_t Reporter: MeltDoctor
properties Quencher: None
Plate layout Task for negative control wells:
Passive Reference: None
Run method Reaction Volume Per Well: 20 pL
Ramp mode and rate (StepOne™ and StepOnePlus™ systems):
Select Continuous, then set the ramp rate to 0.3%
Expert Mode (7500 systems): Select the checkbox
(7500 systems) Click Select/View Filters, then select only Filter-1
Run the plate
Stage Step Temp Time
Holding Enzyme activation 95°C | 10 min
Cycling (40 cycles) Denature 95°C | 15sec
Anneal/extend 60 °C 1 min
Melt curve Denature 95°C | 10sec
Anneal 60 °C 1 min
High resolution melting | 95°C | 15sec
Anneal 60°C | 15sec

40
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Amplify and melt the DNA
Verify that the 1.

Review the Amplification Plot for normal characteristics:
samples amplified .
and review the Tm Fluorescence levels that exceed the threshold between cycles 8 and 35
peaks * An exponential increase in fluorescence
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Note: Note which wells are outliers with C; values that differ from replicates by
more than 2. The outliers may produce erroneous HRM results.

Note: If the Amplification Plot looks abnormal, refer to “Troubleshooting HRM
Experiments” on page 79 to identify and resolve the problem.
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2. Verify that the Melt Curve shows no unexpected Tm peaks:

If the sequence you amplified contains more than 1 SNP or a more complex
mutation, you may see more than 1 Tm peak because of the large differences
between the different sequence types.

Note: Unexpected peaks at low temperatures may indicate contamination, primer
dimers, or non-specific amplification.

Note: The data may appear noisy because more data is collected during a high
resolution melt curve than during a standard melt curve. The extra data are
required for analysis with the HRM Software.
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Review the high-resolution melting data

After you create, run, analyze, and save the *.eds experiment file on your real-time
PCR system, use the High Resolution Melt Software v3.0 (HRM Software) to perform
high resolution melting analysis of the data and make genotype calls.

Example HRM  Example HRM experiment files are located in X:\Applied Biosystems\HRM\
experiments  Examples, where X is the drive where you installed the HRM Software.
* Genotyping Example-HRM.eds
* Class 4 SNP 7500 Fast Example-HRM.eds
* Class 4 SNP StepOnePlus Example -HRM.eds

To follow the example HRM genotyping experiment used in this chapter, use the
Genotyping Example-HRM.eds file.

Note: The example files installed with the software are HRM experiment files and
already have the appropriate HRM calibration files assigned to them.

Open and set up  For more detailed instructions on how to open and set up an HRM experiment, see
the HRM  pages 26 through 30.
experiment

1. Open the *.eds experiment file that was run on your real-time PCR system.

Note: If there is no default HRM calibration file selected for the instrument type,
browse to and select the default HRM calibration file. To change the HRM
calibration file for a selected experiment or for all subsequent HRM experiments,
see page 95.

IMPORTANT! Use the HRM calibration file name to make sure that the HRM
calibration file that is assigned to the HRM experiment is correct. The HRM
calibration file must be:

* Run on the same instrument system (the same instrument, the same block type,
and the same software version) as the run file

* Run using the same reagents (HRM dye and master mix) as the reactions in
your HRM experiment plate

* Run using the same run conditions (the same ramp mode and ramp increment)
as the run file.

The HRM Software cannot distinguish between all calibration files. For example,
it cannot distinguish between two different 7500 v2.0 instruments or between a
StepOnePlus system and a StepOne system.
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2. Set up and assign the controls (optional, only if you do not manually define the
number of variant groups):

IMPORTANT! For hard-to-detect SNPs, you need to either assign controls to the
experiment or manually enter the number of variant groups in the analysis
settings.

a. Add controls to the experiment in the Controls section of the Define screen.
* Controls in Genotyping Example-HRM.eds:

Control Name | Caolar

ol
=
-

Heterozygote

Homozygote

ild Type

* Controls in Class 4 SNP StepOnePlus Example -HRM.eds:

Cantral Name [ color

m-
m=
m-

leteroeygote

omozygote

ild Type

* Controls in Class 4 SNP 7500 Fast Example-HRM.eds:

Gontrol Hame [ color

m

kumtm\ 1

Note: For control names, do not use the convention variantN, where N is any
number (for example, variantl, variant2, and so on). The HRM Software
uses the convention variantN when automatically assigning the variant calls.

b. Assign controls to wells on the Assign screen.

Note: You can assign only one control to a well. To change the control
assigned to a well, remove the existing control assignment first, then make
the new assignment.

3. For each assay in the plate, specify the analysis settings:

a. View an analysis screen, click Analysis Settings (top right corner), then
select an assay from the table of assays on the left.
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b. Specify the settings for the pre-melt and post-melt regions:

» Select the checkbox for the software to automatically set the pre- and
post-melt regions for each well (default setting).

» Deselect the checkbox to manually define the pre- and post-melt regions
for all assay wells:

— Pre-melt region — Pre-melt stop temperature is next to the start of the
melt transition region and pre-melt start temperature is 0.5 to 1 °C lower
than the pre-melt stop temperature.

— Post-melt region — Post-melt start temperature next to the end of the
melt transition region and post-melt stop temperature 0.5 to 1 °C higher
than the pre-melt stop temperature.

c. Specify the settings for the number of variant groups:

» Ifyou defined and assigned controls, make sure the checkbox is selected
so that the software will automatically determine the number of variant
groups based on the melt curve differences for the selected assay
(default setting).

» Ifyou did not define and assign controls, deselect the checkbox, then
enter the number of variant groups to call for the selected assay.

IMPORTANT! The algorithms that assign variant calls according to an
entered number of variant groups are incompatible with the algorithms that
assign variant calls according to the controls that are assigned. If you assign
controls and enter the number of variant groups, you will get unpredictable
results.

d. Click Apply Analysis Settings to close the analysis settings and reanalyze
the experiment.

e. After the reanalysis is complete, save the experiment.

Note: When you save the HRM experiment the first time, “-HRM” is added
to the file name to indicate that the experiment run file is associated with an
HRM calibration file and contains HRM data. You cannot open an HRM
experiment file using the instrument software. The original experiment run
file is maintained. Keep the “~-HRM” in the HRM experiment file name to
distinguish between the *.eds files.
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About the melting
profiles

Review the
populations in the
Aligned Melt
Curves plot

4. (Optional) View the Derivative Melt Curves, set the pre- and post-melt regions as
close as possible to the melting transition region, as in the example below, click
Analyze, then save the changes.

Fluorescence

The melting profile of a PCR product depends on its GC content, length, sequence, and
heterozygosity. High-resolution melting analysis calls variants based on the differences
in the shape of the melt curves and the differences in the Tm values.

In genotyping experiments:
* The heterozygotes have a different curve shape compared to the homozygotes.
The shape of the melt curve is an indicator of heteroduplex formation.

* The two homozygotes are distinguished from each other based on the difference in
Tm values.

The Aligned Melt Curves plot displays the melt curves as % melt (0—100%) over
temperature. The melt curves are aligned to the same fluorescence level using the pre-
and post-melt regions.

1. In the navigation pane, select to view the High Resolution Melt Plots screen,
then select the Aligned Melt Curves tab.

2. Review:

* Variant groups (different colors) — How many different variant groups are
displayed? Does this number correspond to the number of variant groups you
were expecting?

* Qutliers — Are there any curves within a variant group that do not cluster
tightly with the other samples in that group?
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Aligned Melt In the example experiment, there are 3 distinct variant groups, 1 for each genotype.
Curves example  Notice how the curves differ for the variants: The green curves have a different shape,
and the red and blue curves have a similar shape but different Tm.

Review the The Difference Plot displays the aligned data as the difference in fluorescence between
Difference Plot for  the melt curve for a reference sample and the other melt curves. You can select a
outliers  ohtrol or any well as a reference. After you select the reference, the software subtracts
the reference curve from the other curves.

The Difference Plot allows you to more easily see small differences between curves
and identify outliers.

1. In the High Resolution Melt Plots screen, select the Difference Plot tab.

2. From the Reference dropdown menu (above the plot), select the wild type control
as the reference, then review:

* Variant groups — How many distinct clusters are displayed?
* Outliers — How tight are the curves within each variant group?

Difference Plot In the example experiment, there are 3 distinct variant groups, 1 for each genotype. The
example  wild type control (heterozygote) is selected as the reference (blue curves):

Diference
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Review the The HRM Software automatically makes a call for each sample according to the shape
software calls  of the aligned melt curves and the Tm. Review the software calls, then omit outliers or
change calls.

1. In the Results pane, click the Well column header to sort the results according to
the well position.

2. For the positive controls, review:

* Variant Call column — Do all of the positive control replicates have the
correct call?

» Silhouette Score column — Are the silhouette scores close to 1.0 (0.8 to 1.0)?

Note: For wells with low silhouette scores (below 0.8), review the data.

3. For each replicate group, review:
* Variant Call column — Do all replicates have the same call?
+ Silhouette Score column — Are the silhouette scores close to 1.0 (0.8 to 1.0)?

Note: For wells with low silhouette scores (below 0.8), review the data.

4. To view the fluorescence data for certain wells, select the rows in the Results
table.

5. In the Results pane, click the Variant Call column header to sort the results
according to the variant call. For each variant call, review the samples that were
assigned that call.

Omit outliers or  After you review the software calls, you can omit outliers or change calls. Remember
change calls 1o click Analyze to reanalyze the data after you omit outliers or change calls, then save
the changes.

For detailed instructions, see pages 34-35:
* Omit outliers from analysis
* Change calls made by the software
» Revert selected manual calls to the software Auto call

* Revert all manual calls for an assay
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Chapter 4

Perform an HRM Mutation Scanning
Experiment

Perform an HRM mutation scanning experiment to screen DNA samples for new
single-base changes, insertions/deletions, or other unknown mutations.

Perform an HRM Mutation Scanning Experiment

Design the HRM experiment (below)

Prepare the HRM reactions (page 50)

Amplify and melt the DNA (page 52)
Review the high-resolution melting data (page 54)

Sequence the variants (page 60)

Design the HRM experiment

Design and order  Using Primer Express® Software v3.0 or later, design the primers to amplify the
the primers  genomic DNA that spans the mutations of interest. Order the primers from the
Applied Biosystems Store.

1. Design the primers so that they meet these guidelines:

Design attribute Design guidelines

Amplicon Length is less than 250 basepairs

Primer length ~20 bases each

Tm 58 °C to 60 °C (Optimal Tm is 59 °C)

% GC content 30-80% GC content in each primer

3’ end No more than 2 G+C residues in the last 5 nucleotides
at the 3’ end

Repeating Avoid consecutive identical nucleotides. If you are

oligonucleotides unable to avoid consecutive identical nucleotides,
make sure that each primer contains fewer than 4
consecutive Gs.
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Chapter 4 Perform an HRM Mutation Scanning Experiment
Prepare the HRM reactions

If you want to use M13F and M13R primers in the sequencing reaction, add the
appropriate M 13 tail to the 5 end of the primers:

* MI13F (add to the 5” end of the forward primer):
TGTAAAACGACGGCCAGT

* MI13R (add to the 5" end of the reverse primer):
CAGGAAACAGCTATGACC

Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user. For more instructions, see
“Order custom primers” on page 92.

Include controls for each target sequence in your HRM mutation scanning experiment:

At least one negative control
At least one wild type control

Run up to 5 replicates for each wild type control to improve your results. Running
multiple wild type controls allows you to more effectively define the natural
spread or variation within the normal population.

Prepare the HRM reactions

Required materials

50

Prepare the HRM
reactions

Microcentrifuge tubes
Optical reaction plate appropriate for your Real-Time PCR instrument
MicroAmp® Optical Adhesive Film
MeltDoctor™ HRM Master Mix
For each target sequence:
— Forward and reverse primers (5 uM each)
— DNA samples
Deionized water
Pipettors and pipette tips
Vortexer

Centrifuge

Prepare the reactions for each replicate group separately, then transfer the reactions to a

reaction plate appropriate for your instrument.

For information about using the MeltDoctor"” HRM Reagents to optimize your
reactions, see “Optimizing the reaction conditions” on page 93.
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Chapter 4 Perform an HRM Mutation Scanning Experiment

Prepare the HRM reactions

1. Prepare the negative control reactions in an appropriately sized, labeled tube:

Volume for
Volume for three 20-pL
Components one 20-pL replicates
reaction plus
10% excess
MeltDoctor™ HRM Master Mix 10.0 pL 33.00 pL
Primer 1 (5 M) 1.2 L 3.96 pL
Primer 2 (5 uM) 1.2 pL 3.96 L
Deionized water 7.6 uL 25.08 pyL
Total reaction volume 20.0 yL 66.00 pL

IMPORTANT! Include excess volume in your calculations to provide excess

volume for the loss that occurs during reagent transfers. We recommend an excess

volume of at least 10%.

2. Prepare positive control reactions and unknown reactions in separate appropriately

sized, labeled tubes:

Volume for
Volume for three 20-pL
Components one 20-pL replicates
reaction plus 10%
excess
MeltDoctor™ HRM Master Mix 10.0 pL 33.00 pL
Primer 1 (5 uM) 1.2 L 3.96 pL
Primer 2 (5 uM) 1.2 pL 3.96 L
Genomic DNA (20 ng/pL) 1.0 L 3.30 L
Deionized water 6.6 uL 21.78 pL
Total reaction volume 20.0 pL 66.00 pL

IMPORTANT! Include excess volume in your calculations to provide excess

volume for the loss that occurs during reagent transfers. We recommend an excess

volume of at least 10%.

3. Vortex the reactions to mix, then spin the tubes briefly.

4. Prepare a reaction plate appropriate for your instrument:

a. Pipet each reaction replicate to the appropriate wells of the optical reaction

plate.

b. Seal the reaction plate with optical adhesive film, then spin the reaction plate.
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c. Confirm that the liquid is at the bottom of the wells in the reaction plate.

Note: If you plan to wait more than 24 hours before running the plate, store the
plate at 4 °C. Allow the plate to warm to room temperature, then spin the plate
briefly before running it.

Amplify and melt the DNA

After you have prepared the reaction plate, run the plate to amplify and melt the DNA
and to generate HRM fluorescence data. This chapter contains brief instructions. For
detailed instructions, see page 21.

Create and set up a  Using the real-time PCR instrument software, open and set up the HRM experiment
new experiment file  yn file:
for the HRM run

Setup Setting

Experiment e Experiment type: Quantitation - Standard Curve
properties e Reagents: Other, then select the Include Melt Curve checkbox
e Ramp speed: Standard (~ 2 hours to complete a run)

Target * Reporter: MeltDoctor
properties ¢ Quencher: None

Plate layout ¢ Task for negative control wells:
¢ Passive Reference: None

Run method ¢ Reaction Volume Per Well: 20 pL

¢ Ramp mode and rate (StepOne™ and StepOnePlus™ systems):
Select Continuous, then set the ramp rate to 0.3%

e Expert Mode (7500 systems): Select the checkbox
e (7500 systems) Click Select/View Filters, then select only Filter-1

Run the plate

Stage Step Temp Time

Holding Enzyme activation 95°C | 10 min
Cycling (40 cycles) Denature 95°C | 15sec
Anneal/extend 60 °C 1 min

Melt curve Denature 95°C | 10sec
Anneal 60 °C 1 min

High resolution melting | 95°C | 15sec

Anneal 60°C | 15sec
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Verify that the 1. Review the Amplification Plot for normal characteristics:
:ﬁ:ﬁnfelsise\?vr?ﬁgfjl'eg » Fluorescence levels that exceed the threshold between cycles 8 and 35
peaks .

An exponential increase in fluorescence
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Note: Note which wells are outliers with C; values that differ from replicates by
more than 2. The outliers may produce erroneous HRM results.

Note: If the Amplification Plot looks abnormal, refer to “Troubleshooting HRM
Experiments” on page 79 to identify and resolve the problem.
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2. Verify that the Melt Curve shows no unexpected Tm peaks:

If the sequence you amplified contains more than 1 variant or a more complex
mutation, you may see more than 1 Tm peak because of the large differences
between the different sequence types.

Note: Unexpected peaks at low temperatures may indicate contamination, primer
dimers, or non-specific amplification.

Note: The data may appear noisy because more data is collected during a high
resolution melt curve than during a standard melt curve. The extra data are
required for analysis with the HRM Software.
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Review the high-resolution melting data

After you create, run, analyze, and save the *.eds experiment file on your real-time
PCR system, use the High Resolution Melt Software v3.0 (HRM Software) to perform
high resolution melting analysis of the data and screen the samples for mutations.

Example HRM  Example HRM experiment files are located in X:\Applied Biosystems\HRM\
experiments  Examples, where X is the drive where you installed the HRM Software.

To follow the example HRM mutation scanning experiment used in this chapter, use
the Mutation Scanning Example-HRM.eds file.

Note: The example files installed with the software are HRM experiment files and
already have the appropriate HRM calibration files assigned to them.

Open and set up  For more detailed instructions on how to open and set up an HRM experiment, see

the HRM  pages 26 through 30.
experiment
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1. Open the *.eds experiment file that was run on your real-time PCR system.

Note: If there is no default HRM calibration file selected for the instrument type,
browse to and select the default HRM calibration file. To change the HRM
calibration file for a selected experiment or for all subsequent HRM experiments,
see page 95.

IMPORTANT! Use the HRM calibration file name to make sure that the HRM
calibration file that is assigned to the HRM experiment is correct. The HRM
calibration file must be:

* Run on the same instrument system (the same instrument, the same block type,
and the same software version) as the run file

* Run using the same reagents (HRM dye and master mix) as the reactions in
your HRM experiment plate

* Run using the same run conditions (the same ramp mode and ramp increment)
as the run file.

The HRM Software cannot distinguish between all calibration files. For example,
it cannot distinguish between two different 7500 v2.0 instruments or between a
StepOnePlus system and a StepOne system.

2. Set up and assign the controls:

a. Add controls to the experiment in the Controls section of the Define screen.
Controls in Mutation Scanning Example-HRM.eds:

Contral Name Color

Het hd

Hom o~

Note: For control names, do not use the convention variantN, where N is any
number (for example, variantl, variant2, and so on). The HRM Software
uses the convention variantN when automatically assigning the variant calls.

b. Assign controls to wells on the Assign screen.

Note: You can assign only one control to a well. To change the control
assigned to a well, remove the existing control assignment first, then make
the new assignment.

3. For each assay in the plate, specify the analysis settings:

a. View an analysis screen, click Analysis Settings (top right corner), then
select an assay from the table of assays on the left.
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b. Specify the settings for the pre-melt and post-melt regions:

» Select the checkbox for the software to automatically set the pre- and
post-melt regions for each well (default setting).

» Deselect the checkbox to manually define the pre- and post-melt regions
for all assay wells:

— Pre-melt region — Pre-melt stop temperature is next to the start of the
melt transition region and pre-melt start temperature is 0.5 to 1 °C lower
than the pre-melt stop temperature.

— Post-melt region — Post-melt start temperature next to the end of the
melt transition region and post-melt stop temperature 0.5 to 1 °C higher
than the pre-melt stop temperature.

c. For the number of variant groups, make sure the checkbox is selected so that

the software will automatically determine the number of variant groups to
call based on the melt curve differences for the selected assay (default
setting).

IMPORTANT! If you assigned controls, you need to select the checkbox for
the software to automatically set the number of variant groups. The
algorithms that assign variant calls according to an entered number of variant
groups are incompatible with the algorithms that assign variant calls
according to the controls that are assigned. If you assign controls and enter
the number of variant groups, you will get unpredictable results.

. Click Apply Analysis Settings to close the analysis settings and reanalyze

the experiment.

. After the reanalysis is complete, save the experiment.

Note: When you save the HRM experiment the first time, “-HRM” is added
to the file name to indicate that the experiment run file is associated with an
HRM calibration file and contains HRM data. You cannot open an HRM
experiment file using the instrument software. The original experiment run
file is maintained. Keep the “~-HRM” in the HRM experiment file name to
distinguish between the *.eds files.
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4. (Optional) View the Derivative Melt Curves, set the pre- and post-melt regions as
close as possible to the melting transition region, as in the example below, click
Analyze, then save the changes.

860
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Fluorescence
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About the melting  The melting profile of a PCR product depends on its GC content, length, sequence, and
profiles  heterozygosity. High-resolution melting analysis calls variants based on the differences
in the shape of the melt curves and the differences in the Tm values.

In mutation scanning experiments, the variants have a different curve shape or Tm
compared to the wild type.

Review the  The Aligned Melt Curves plot displays the melt curves as % melt (0-100%) over
populations in the  temperature. The melt curves are aligned to the same fluorescence level using the

Aligned Melt i ) ,
Curves plot pre- and post-melt regions.

1. In the navigation pane, select to view the High Resolution Melt Plots screen,
then select the Aligned Melt Curves tab.

2. Review:

»  Wild type controls — Do the melt curves for the wild type controls cluster
well? Are there any outliers?

* Possible mutations — Are there any samples with melt curves that are
different from the wild type melt curves?
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Aligned Melt In the example experiment, there is 1 distinct variant group for the wild type (Hom)
Curves example  samples. The samples with curves that vary from the wild type form another distinct
variant group and may contain mutations.

Review the The Difference Plot displays the aligned data as the difference in fluorescence between
Difference Plot for  the melt curve for a reference sample and the other melt curves. You can select a
outliers  ohtrol or any well as a reference. After you select the reference, the software subtracts
the reference curve from the other curves.

The Difference Plot allows you to more easily see small differences between curves
and identify outliers.

1. In the High Resolution Melt Plots screen, select the Difference Plot tab.

2. From the Reference dropdown menu (above the plot), select a control or any well
as the reference, then review:

* Variant groups — How many distinct clusters are displayed?

* Outliers — How tight are the curves within each variant group?

Note: Try selecting different reference samples to find the optimal display of the
groups.

Difference Plot  In the example experiment, there are 2 distinct variant groups. The wild type control
example  (homozygote) is selected as the reference (red curves):

Difierence
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Review the The HRM Software automatically makes a call for each sample according to the shape
software calls  of the aligned melt curves and the Tm. Review the software calls, then omit outliers or
change calls.

1. In the Results pane, click the Well column header to sort the results according to
the well position.

2. For each replicate group, review:
* Variant Call column — Do all replicates have the same call?

+ Silhouette Score column — Are the silhouette scores close to 1.0 (0.8 to 1.0)?

Note: For wells with low silhouette scores (below 0.8), review the data.

3. To view the fluorescence data for certain wells, select the rows in the Results
table.

4. In the Results pane, click the Variant Call column header to sort the results
according to the variant call. Scan the results for samples that were not assigned
the same call as the wild type control.

Omit outliers or  After you review the software calls, you can omit outliers or change calls. Remember
change calls 1o click Analyze to reanalyze the data after you omit outliers or change calls, then save
the changes.

For detailed instructions, see pages 34-35:
*  Omit outliers from analysis
* Change calls made by the software
* Revert selected manual calls to the software Auto call

+ Revert all manual calls for an assay
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Sequence the variants

After you identify the variants in the HRM software, dilute or purify the PCR product
from the HRM reactions, then sequence the variants.

Dilute the PCR 1. After the PCR amplification, spin the HRM reaction plate at 100 x g for 1 minute.
product

2. Perform DNA quantitation of the PCR products for the selected variants, then
dilute to 0.5-1.5 ng/ulL with water.

3. Use the dilution ratio to determine whether you need to purify the PCR product
before performing the sequencing reactions:

How much did you dilute
the PCR product? Next step
<1:20 Purify the PCR product using ExoSAP-IT® (next
procedure) before performing the sequencing
reactions.
>1:20 Perform the sequencing reactions using the diluted
DNA (page 61).

Purify the PCR  If you diluted the PCR product less than 1:20, purify the PCR product using
product  ExoSAP-IT®.

1. Combine the diluted PCR product and ExoSAP-IT in a clean MicroAmp® Fast
Optical Reaction Plate:

Component Volume
Diluted PCR product 10 pL
ExoSAP-IT® 2 L
Total reaction volume 12 yL

2. Mix the reactions well by pipetting up and down with a multichannel pipettor, then
seal the plate with MicroAmp® Clear Adhesive Film.

3. Spin the plate at 1600 x g for 30 seconds.

4. Load the plate in the thermal cycler, cover the plate with a MicroAmp® Optical
Film Compression Pad, then run the reactions in a thermal cycler:

* Reaction volume: 12 pL
» Thermal profile:

Stage Temp Time

1 37°C | 30 min
2 80°C 15 min
3 4°C o
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5. After the run is complete, spin the plate at 100 x g for 1 minute.

Perform the  Perform fast cycle sequencing with modifications to the protocol for the BigDye®
sequencing  Terminator v1.1 Cycle Sequencing Kit. If your PCR products contain an M13 tail from

reactions

primers for the forward and reverse

primers.

the primers you used in the HRM amplification reactions, use the M13F and M13R

1. On ice, prepare 8 pL of Sequencing Master Mix for each sample:

Component Volume
BigDye® Terminator v1.1 2uL
Forward primer or reverse primer (3.2 pmol each) 1L
Deionized water 4 uL
BigDye® Terminator v1.1, v3.1 5X Sequencing 1L
Buffer
Total volume per reaction 8 uL

Note: Include 5-10% excess volume in the master mix to compensate for

pipetting error.

2. Transfer 8 uL of Sequencing Master Mix to wells of a 96-well reaction plate.

3. Add 2 uL of diluted DNA to the appropriate wells of the reaction plate, then pipet

up and down to mix.

4. Seal the plate with MicroAmp® Clear Adhesive Film, then spin briefly.

5. Run the reactions in a Veriti' 96-Well Fast Thermal Cycler:

* Reaction volume: 10 pL

* Thermal profile:

Stage Step Temp Time
Holding Denaturation 96 °C 1 min
Cycle sequencing (25 Denaturation 96 °C | 10sec
cycles) Annealing 50 °C 3 sec
Extension 60°C | 75sec

Holding Holding 4°C oo

Note: Use a rapid thermal ramp (1 °C/second) for each new temperature.

6. After the run is complete, spin the plate briefly.
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Use the BigDye XTerminator® Purification Kit to remove unincorporated BigDye®
terminators. For more instructions on the purification or on transferring the plate to the
DNA Analyzer, refer to the BigDye XTerminator® Purification Kit Protocol

(PN 4374408).

1. Spin the reaction plate briefly, then add BigDye XTerminator reagents:
a. Add 45 uL of SAM™ Solution to each reaction.

b. Vortex the BigDye XTerminator® Solution thoroughly, then use a wide-bore
pipette tip to add 10 pL to each reaction.

2. Seal the plate with MicroAmp® Clear Adhesive Film, then verify that each well is
sealed.

3. Vortex the plate for 30 minutes.

4. Spin the plate at 1000 x g for 2 minutes.

Run the sequencing reaction products on an Applied Biosystems 3500/3500x/ DNA
Analyzer, 3730/3730x/ DNA Analyzer, 3130/3130x/ Genetic Analyzer, or 3100/3100-
Avant™ Genetic Analyzer. For more instructions, refer to the user guide for your
instrument.

Applied Biosystems Applied Biosystems Applied Biosystems ABI PRISM®
3500/3500x/ DNA 3730/3730x/ DNA 3130/3130x/ DNA 3100/3100-Avant™
Item Analyzer with 3500 Analyzers with Data Analyzer with Data Genetic Analyzer with
Data Collection Collection Software Collection Data Collection
Software v1.0 vi.1, v2.0, or v3.0 Software v2.0 Software v2.0
Polymer POP-7™ polymer POP-7™ polymer POP-6™ polymer POP-6™ polymer
Array 50 cm 36 cm 36 cm 36 cm
Run file RapidSeq_BDX_50_ BDX_RapidSeq36_ BDX_RapidSeq36_ BDX_RapidSeq36_
POP7 POP7 POP6 POP6
Mobility Kb_3500_POP6_BDV1 KB_3730_POP7_BDTv1l = Kb_3130_POP6_BDV1. Kb_3100_POP6_BDV1.
file .mob mob mob
Basecaller KB KB KB KB
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Chapter 5

Perform HRM Methylation Studies

Perform HRM methylation studies to determine the percentage of methylated DNA in
unknown samples.

Perform HRM Methylation Studies

Design the HRM experiment (below)
Optimize the HRM reactions (page 64)
Prepare the HRM reactions (page 65)
Amplify and melt the DNA (page 67)
Review the high-resolution melting data (page 70)

Sequence the variants (page 75)

Design the HRM experiment

Design and order  Using Methyl Primer Express® Software, design the primers to amplify the genomic
the primers  DNA that spans the methylation sites of interest. With Methyl Primer Express
Software, you can specify the number of CpG dinucleotides to include in the PCR
primers and their position. Order the primers from the Applied Biosystems Store.
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1. Design the primers so that they meet these guidelines:

Design attribute Design guidelines

Amplicon e |ength is less than 250 basepairs

¢ To detect high levels of methylation, primers lie
outside of the CpG island

¢ To detect low levels of methylation, primer
sequences include CpG dinucleotides

Primer length ~20 bases each

Tm 58 °C to 60 °C (Optimal Tm is 59 °C)

% GC content 30-80% GC content in each primer

3’ end No more than 2 G+C residues in the last 5 nucleotides
at the 3’ end

Repeating Avoid consecutive identical nucleotides. If you are

oligonucleotides unable to avoid consecutive identical nucleotides,

make sure that each primer contains fewer than 4
consecutive Gs.

2. Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user. For more instructions, see
“Order custom primers” on page 92.

Plan to use controls Include controls for each target sequence in your HRM methylation study:

* At least one negative control
* Methylated DNA standards that contain from 0% to 100% methylated DNA

Optimize the HRM reactions

Optimize the HRM reactions to identify the most suitable PCR reaction to study a
differentially methylated region.

1. Prepare the HRM reactions: Test different reaction conditions.

2. Amplify and melt the DNA: Review the C; values to quantify the efficiency of the
PCR reaction.

3. Review the HRM data: Review the specificity of the PCR reaction and the melting
behavior of the PCR fragments.

4. Perform electrophoresis of the PCR products on high-percentage agarose gels:
Verify the size of the amplicon and review the specificity of the PCR reaction.
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Prepare the HRM reactions

Combine purified genomic DNA templates with MeltDoctor'” HRM Master Mix and
primers to amplify the target sequence.

Note: If you are using the MeltDoctor” HRM Reagents instead of the MeltDoctor ™™
HRM Master Mix, see page 93 for reaction component volumes.

Prepare the  Use the Cells-to-CpG™ Methylated and Unmethylated gDNA Control Kit, and mix

methylated DNA  different ratios of 100% methylated and 0% methylated DNA. For example:
standards

DNA Volume to prepare the methylated DNA standard

100% methylated DNA (20 ng/uL) | 10puL 7.5 pL 5uL 2.5puL 1L 0pL
Non-methylated DNA (20 ng/pL) 0L 2.5uL 5uL 7.5 L 9L 10 uL
% methylated DNA 100% 75% 50% 25% 10% 0%

Note: To detect low levels of methylation, add more standards between 0% and 2%
methylation. For example, prepare standards to represent 0.0%, 0.1%, 0.5%, 1%, 2%,
5%, 10%, and 100% methylation.

Treat the samples  Before you perform the HRM reactions for your methylation study, treat your samples
and methylated  and methylated DNA standards with bisulfite to convert non-methylated cytosines (C)
DNA standards with  ;, your DNA to uracil (U). Samples that vary in the number of U residues within the
bisulfite . . i
amplified sequence will have distinct melt curve shapes and Tm values.

We recommend that you use one of the Cells-to-CpG™ Bisulfite Conversion Kits. For
instructions, refer to the Cells-to-CpG"" Bisulfite Conversion Kit (2x96) Protocol
(PN 4449006) or the Cells-to-CpG"" Bisulfite Conversion Kit (50) Protocol

(PN 4448998).

Required materials * Microcentrifuge tubes

* Optical reaction plate appropriate for your Real-Time PCR instrument

+  MicroAmp® Optical Adhesive Film

+ MeltDoctor"™ HRM Master Mix

» For each target sequence:
— Forward and reverse primers (5 uM each)
— DNA samples

* Methylated DNA standards

* Deionized water

* Pipettors and pipette tips

* Vortexer

* Centrifuge
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Prepare the HRM
reactions

For information about using the MeltDoctor'” HRM Reagents to optimize your

Chapter 5 Perform HRM Methylation Studies

Prepare the reactions for each replicate group separately, then transfer the reactions to a
reaction plate appropriate for your instrument.

reactions, see “Optimizing the reaction conditions” on page 93.

1. Prepare the negative control reactions in an appropriately sized, labeled tube:
Volume for
Volume for three 20-pL
Components one 20-pL replicates
reaction plus
10% excess
MeltDoctor™ HRM Master Mix 10.0 pL 33.00 pL
Primer 1 (5 M) 1.2 uL 3.96 pL
Primer 2 (5 uM) 1.2 pL 3.96 L
Deionized water 7.6 uL 25.08 pL
Total reaction volume 20.0 yL 66.00 pL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. We recommend an excess
volume of at least 10%.

2. Prepare methylated DNA standards and unknown reactions in separate
appropriately sized, labeled tubes:

Volume for
Volume for three 20-pL
Components one 20-pL replicates
reaction plus 10%
excess
MeltDoctor™ HRM Master Mix 10.0 pL 33.00 pL
Primer 1 (5 pM) 1.2 uL 3.96 pL
Primer 2 (5 uM) 1.2 pL 3.96 L
Genomic DNA (20 ng/pL) 1.0 yL 3.30 L
Deionized water 6.6 uL 21.78 pL
Total reaction volume 20.0 pL 66.00 pL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. Applied Biosystems
recommends an excess volume of at least 10%.

3. Vortex the reactions to mix, then spin the tubes briefly.

4. Prepare a reaction plate appropriate for your instrument:

a. Pipet each reaction replicate to the appropriate wells of the optical reaction
plate.
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b. Seal the reaction plate with optical adhesive film, then spin the reaction plate.

c. Confirm that the liquid is at the bottom of the wells in the reaction plate.

Note: If you plan to wait more than 24 hours before running the plate, store the
plate at 4 °C. Allow the plate to warm to room temperature, then spin the plate
briefly before running it.

Amplify and melt the DNA

After you have prepared the reaction plate, run the plate to amplify and melt the DNA
and to generate HRM fluorescence data. This chapter contains brief instructions. For
detailed instructions, see page 21.

Create and setup a  Using the real-time PCR instrument software, open and set up the HRM experiment
new experiment file  yn file:
for the HRM run

Setup Setting

Experiment e Experiment type: Quantitation - Standard Curve
properties ¢ Reagents: Other, then select the Include Melt Curve checkbox
e Ramp speed: Standard (~ 2 hours to complete a run)

Target * Reporter: MeltDoctor
properties ¢ Quencher: None

Plate layout e Task for negative control wells:
* Passive Reference: None

Run method e Reaction Volume Per Well: 20 pL

¢ Ramp mode and rate (StepOne™ and StepOnePlus™ systems):
Select Continuous, then set the ramp rate to 0.3%

e Expert Mode (7500 systems): Select the checkbox
e (7500 systems) Click Select/View Filters, then select only Filter-1

Run the plate

Stage Step Temp Time

Holding Enzyme activation 95°C | 10 min
Cycling (40 cycles) Denature 95°C | 15sec
Anneal/extend 60 °C 1 min

Melt curve Denature 95°C | 10sec
Anneal 60 °C 1 min

High resolution melting | 95°C | 15sec

Anneal 60°C @ 15sec

Note: For methylation experiments, adjust the annealing temperature during the
amplification to increase or decrease the extent of the PCR bias.
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Verify that the 1. Review the Amplification Plot for normal characteristics:

asr?:aneISise\?vn;ﬁgf'il'eg » Fluorescence levels that exceed the threshold between cycles 8 and 35

peaks * An exponential increase in fluorescence
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ARN
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Note: Note which wells are outliers with C; values that differ from replicates by
more than 2. The outliers may produce erroneous HRM results.

Note: If the Amplification Plot looks abnormal, refer to “Troubleshooting HRM
Experiments” on page 79 to identify and resolve the problem.
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2. Verify that the Melt Curve shows no unexpected Tm peaks:

With methylation experiments, you will likely see multiple peaks. The number of
peaks in the melt curve is correlated with the number of methylation sites in the
amplicon.

Note: Unexpected peaks at low temperatures may indicate contamination, primer
dimers, or non-specific amplification.

Note: The data may appear noisy because more data is collected during a high
resolution melt curve than during a standard melt curve. The extra data are
required for analysis with the HRM Software.
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The low methylation example above shows multiple Tm peaks because of the
large differences between the samples with low methylation and the wild type
samples. Notice that there are no large Tm peaks at the lower temperatures.
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Review the high-resolution melting data

After you create, run, analyze, and save the *.eds experiment file on your real-time
PCR system, use the High Resolution Melt Software v3.0 (HRM Software) to perform
high resolution melting analysis of the data and review the methylation data.

Example HRM  Example HRM experiment files are located in X:\Applied Biosystems\HRM\
experiments  Examples, where X is the drive where you installed the HRM Software.

To follow the example HRM methylation study used in this chapter, use the
Low Percent Methylation Titration-HRM.eds file.

Note: The example files installed with the software are HRM experiment files and
already have the appropriate HRM calibration files assigned to them.

Open and set up  For more detailed instructions on how to open and set up an HRM experiment, see
the HRM  pages 26 through 30.
experiment

1. Open the *.eds experiment file that was run on your real-time PCR system.

Note: If there is no default HRM calibration file selected for the instrument type,
browse to and select the default HRM calibration file. To change the HRM
calibration file for a selected experiment or for all subsequent HRM experiments,
see page 95.

IMPORTANT! Use the HRM calibration file name to make sure that the HRM
calibration file that is assigned to the HRM experiment is correct. The HRM
calibration file must be:

* Run on the same instrument system (the same instrument, the same block type,
and the same software version) as the run file

* Run using the same reagents (HRM dye and master mix) as the reactions in
your HRM experiment plate

* Run using the same run conditions (the same ramp mode and ramp increment)
as the run file.

The HRM Software cannot distinguish between all calibration files. For example,
it cannot distinguish between two different 7500 v2.0 instruments or between a
StepOnePlus system and a StepOne system.
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2. Set up and assign the controls:

a. Add controls to the experiment in the Controls section of the Define screen.
Controls in Low Percent Methylation Titration-HRM.eds:

Cantrol Marme | Color
0% |. -
D.1% | v
I.5% |. -
1% | v
10% |. v
1007 |. -
% | v
% |. -

Note: Add a control for each known methylation percentage.

Note: For control names, do not use the convention variantN, where N is any
number (for example, variantl, variant2, and so on). The HRM Software
uses the convention variantN when automatically assigning the variant calls.

b. Assign controls to wells on the Assign screen.

Note: You can assign only one control to a well. To change the control
assigned to a well, remove the existing control assignment first, then make
the new assignment.

3. For each assay in the plate, specify the analysis settings:

a. View an analysis screen, click Analysis Settings (top right corner), then
select an assay from the table of assays on the left.

b. Specify the settings for the pre-melt and post-melt regions:

» Select the checkbox for the software to automatically set the pre- and
post-melt regions for each well (default setting).

* Deselect the checkbox to manually define the pre- and post-melt regions
for all assay wells:

— Pre-melt region — Pre-melt stop temperature is next to the start of the
melt transition region and pre-melt start temperature is 0.5 to 1 °C lower
than the pre-melt stop temperature.

— Post-melt region — Post-melt start temperature next to the end of the
melt transition region and post-melt stop temperature 0.5 to 1 °C higher
than the pre-melt stop temperature.
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About the melting

72

profiles

c. For the number of variant groups, make sure the checkbox is selected so that

the software will automatically determine the number of variant groups to
call based on the melt curve differences for the selected assay (default
setting).

IMPORTANT! If you assigned controls, you need to select the checkbox for
the software to automatically set the number of variant groups. The
algorithms that assign variant calls according to an entered number of variant
groups are incompatible with the algorithms that assign variant calls
according to the controls that are assigned. If you assign controls and enter
the number of variant groups, you will get unpredictable results.

. Click Apply Analysis Settings to close the analysis settings and reanalyze

the experiment.

. After the reanalysis is complete, save the experiment.

Note: When you save the HRM experiment the first time, “-HRM” is added
to the file name to indicate that the experiment run file is associated with an
HRM calibration file and contains HRM data. You cannot open an HRM
experiment file using the instrument software. The original experiment run
file is maintained. Keep the “~-HRM” in the HRM experiment file name to
distinguish between the *.eds files.

4. (Optional) View the Derivative Melt Curves, set the pre- and post-melt regions as
close as possible to the melting transition region, as in the example below, click
Analyze, then save the changes.

Fluorescence

The melting profile of a PCR product depends on its GC content, length, sequence, and
heterozygosity. High-resolution melting analysis calls variants based on the differences
in the shape of the melt curves and the differences in the Tm values.

In methylation studies, the shape of the melt curve and the Tm values vary according to
the number of C residues converted to U after the bisulfite treatment.
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The Aligned Melt Curves plot displays the melt curves as % melt (0-100%) over
temperature. The melt curves are aligned to the same fluorescence level using the
pre- and post-melt regions.

1. In the navigation pane, select to view the High Resolution Melt Plots screen,
then select the Aligned Melt Curves tab.

2. Review:

* Methylated DNA standards — Do the melt curves for the methylated DNA
standards cluster well? Are there any outliers?

* Define the methylation range for unknowns — Which methylated standard
melt curves are above and below the melt curves for the unknowns? For
example, if the melt curve for an unknown sample lies between the melt
curves for the 5% and 10% methylated standards, the unknown sample
contains between 5% and 10% methylated nucleotides.

In the example experiment, there are 8 distinct variant groups, 1 for each methylation
standard.

The Difference Plot displays the aligned data as the difference in fluorescence between
the melt curve for a reference sample and the other melt curves. You can select a
control or any well as a reference. After you select the reference, the software subtracts
the reference curve from the other curves.

The Difference Plot allows you to more easily see small differences between curves
and identify outliers.

1. In the High Resolution Melt Plots screen, select the Difference Plot tab.

2. From the Reference dropdown menu (above the plot), select a control or any well
as the reference, then review:

* Variant groups — How many distinct clusters are displayed?
* Outliers — How tight are the curves within each variant group?

Note: Try selecting different reference samples to find the optimal display of the
groups.
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Difference Plot  In the example experiment, there are 8 distinct variant groups, 1 for each methylation
example  standard. The 0% methylation standard is selected as the reference (pink curves):

Review the The HRM Software automatically makes a call for each sample according to the shape
software calls  of the aligned melt curves and the Tm. Review the software calls, then omit outliers or
change calls.

1. In the Results pane, click the Well column header to sort the results according to
the well position.

2. For the methylation standard controls, review:

* Variant Call column — Do all of the methylation standard controls have the
correct call?

» Silhouette Score column — Are the silhouette scores close to 1.0 (0.8 to 1.0)?

Note: For wells with low silhouette scores (below 0.8), review the data.

3. To view the fluorescence data for certain wells, select the rows in the Results
table.

Omit outliers or  After you review the software calls, you can omit outliers or change calls. Remember
change calls 1o click Analyze to reanalyze the data after you omit outliers or change calls, then save
the changes.

For detailed instructions, see pages 34-35:
*  Omit outliers from analysis
* Change calls made by the software
» Revert selected manual calls to the software Auto call

* Revert all manual calls for an assay

74 HRM Experiments Using MeltDoctor™ HRM Reagents and High Resolution Melt Software v3.0 User Guide



Sequence the variants

Chapter 5 Perform HRM Methylation Studies 5
Sequence the variants

After you identify the samples that contain methylated C residues in the amplified
region, dilute or purify the PCR product from the HRM reactions, then sequence the
variants. Because the samples were treated with bisulfite before the HRM reactions,
the U residues in the sequencing results correspond to methylated C residues.

Dilute the PCR 1. After the PCR amplification, spin the HRM reaction plate at 100 x g for 1 minute.

product

2. Perform DNA quantitation of the PCR products for the selected variants, then
dilute to 0.5-1.5 ng/ulL with water.

3. Use the dilution ratio to determine whether you need to purify the PCR product
before performing the sequencing reactions:

How much did you dilute
the PCR product?

Next step

<1:20

>1:20

Purify the PCR product using ExoSAP-IT® (next
procedure) before performing the sequencing
reactions.

Perform the sequencing reactions using the diluted
DNA (page 76).

Purify the PCR  If you diluted the PCR product less than 1:20, purify the PCR product using

product ExoSAP-IT®.

1. Combine the diluted PCR product and ExoSAP-IT in a clean MicroAmp® Fast

Optical Reaction Plate:

Component Volume

Diluted PCR product
Ex0SAP-IT®

Total reaction volume

10 pL
2 uL
12 yL

2. Mix the reactions well by pipetting up and down with a multichannel pipettor, then
seal the plate with MicroAmp® Clear Adhesive Film.

3. Spin the plate at 1600 x g for 30 seconds.
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4. Load the plate in the thermal cycler, cover the plate with a MicroAmp® Optical
Film Compression Pad, then run the reactions in a thermal cycler:

* Reaction volume: 12 pL
» Thermal profile:

Stage @ Temp Time

1 37 °C | 30 min
80 °C 15 min
3 4°C oo

5. After the run is complete, spin the plate at 100 x g for 1 minute.

Perform the  Perform fast cycle sequencing with modifications to the protocol for the BigDye®
sequencing  Terminator v1.1 Cycle Sequencing Kit. If your PCR products contain an M13 tail from
reactions ¢ primers you used in the HRM amplification reactions, use the M13F and M13R

primers for the forward and reverse primers.

1. Onice, prepare 8 pL of Sequencing Master Mix for each sample:

Component Volume
BigDye® Terminator v1.1 2 uL
Forward primer or reverse primer (3.2 pmol each) 1L
Deionized water 4 L
BigDye® Terminator v1.1, v3.1 5X Sequencing 1L
Buffer
Total volume per reaction 8 uL

Note: Include 5-10% excess volume in the master mix to compensate for
pipetting error.

2. Transfer 8 pL of Sequencing Master Mix to wells of a 96-well reaction plate.

3. Add 2 pL of diluted DNA to the appropriate wells of the reaction plate, then pipet
up and down to mix.

4. Seal the plate with MicroAmp® Clear Adhesive Film, then spin briefly.
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5. Run the reactions in a Veriti' 96-Well Fast Thermal Cycler:

* Reaction volume: 10 pL
* Thermal profile:

Stage Step Temp Time
Holding Denaturation 96 °C 1 min
Cycle sequencing (25 Denaturation 96°C | 10sec
cycles) Annealing 50 °C 3 sec
Extension 60°C | 75sec

Holding Holding 4°C oo

Note: Use a rapid thermal ramp (1 °C/second) for each new temperature.

6. After the run is complete, spin the plate briefly.

Purify the  Use the BigDye XTerminator® Purification Kit to remove unincorporated BigDye®
sequencing  terminators. For more instructions on the purification or on transferring the plate to the
reaction  pa Analyzer, refer to the BigDye XTerminator® Purification Kit Protocol

(PN 4374408).

1. Spin the reaction plate briefly, then add BigDye XTerminator reagents:

a. Add 45 uL of SAM™ Solution to each reaction.

b. Vortex the BigDye XTerminator® Solution thoroughly, then use a wide-bore

pipette tip to add 10 pL to each reaction.

2. Seal the plate with MicroAmp® Clear Adhesive Film, then verify that each well

is sealed.

3. Vortex the plate for 30 minutes.

4. Spin the plate at 1000 x g for 2 minutes.
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Run the sequencing reaction products on an Applied Biosystems 3500/3500x/ DNA
Analyzer, 3730/3730x/ DNA Analyzer, 3130/3130x/ Genetic Analyzer, or 3100/3100-

Avant™ Genetic Analyzer. For more instructions, refer to the user guide for your

instrument.

Applied Biosystems
3500/3500x/ DNA Analyzer

Applied Biosystems
3130/3130x/ DNA Analyzer

ABI PRISM®
3100/3100-Avant™ Genetic

ltem with 3500 Data Collection with Data Collection Analyzer with Data
Software v1.0 Software v2.0 Collection Software v2.0
Polymer POP-6™ polymer POP-4™ polymer POP-4™ polymer
Array 50 cm 36 cm 36 cm
Run file StsSeq_BDX_50_POP6 BDX_RapidSeq36_POP4 BDX_RapidSeq36_POP4
Mobility file | Kb_3500_POP6_BDV1 Kb_3130_POP4_BDV1.mob Kb_3100_POP4_BDV1.mob
Basecaller =~ KB KB KB
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Chapter 6

Troubleshooting HRM Experiments

Problems with HRM experiments are usually evidenced by abnormal amplification
plots or by abnormal HRM curves.

Observation Page

Abnormal amplification plots

Late amplification: C; value >30 for a majority of samples 80
Some late amplification: C; value >30 for some samples 80
PCR inhibition: Amplification curve with low slope and C; values higher than expected 81
Nonspecific amplification: Decreased PCR efficiency and multiple amplicons 82
Abnormal HRM curves

Replicates are widely spread: Sample replicates show a wide spread in HRM curves ' 83
Multiple melt regions: Complex melt curves with multiple melting regions 83
More than three different variant calls (HRM genotyping experiments only) 84
Messy HRM curves: Diagonal wavy curves below heterozygous clusters 84

For more guidance on troubleshooting, refer to:
* Applied Biosystems Real-Time PCR Troubleshooting Tool:
www.appliedbiosystems.com/troubleshoot

» Applied Biosystems Guide to High Resolution Melting (HRM) Analysis (Stock
number 0-081740-0509)
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Chapter 6 Troubleshooting HRM Experiments
Late ampilification: Cy value >30 for a majority of samples

Late amplification: C; value >30 for a majority of samples

The amplification reaction may not reach the plateau phase. HRM resolution may be
affected by the lower increase in fluorescence.

Possible causes Recommended action
Poor DNA quality. Re-extract the DNA.
Amount of DNA added to the HRM reactions is too low. Perform PCR optimization, and increase sample input or

increase the number of amplification cycles.

Some late amplification: C; value >30 for some samples

Sample outliers with C; values that are greater than those for the replicates also have a
Tm shift in the HRM curve. The resulting Tm shift may affect the variant call.

Possible causes Recommended action
Reaction volume for the outlier is visibly greater than or Repeat the HRM reactions, and make sure that you add
less than the reaction volume for the replicates. the correct volumes to each well. Also, after you seal the
plate, spin the plate briefly.
Amount of DNA added to the HRM reactions is too low. Repeat the HRM reactions with more DNA in each
reaction.
PCR inhibition. If the amplification curve also has a low slope and all

replicates for a sample are affected, see page 81 to
troubleshoot PCR inhibition in your HRM reactions.
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Chapter 6  Troubleshooting HRM Experiments
PCR inhibition: Amplification curve with low slope and Cy values higher than expected

PCR inhibition: Amplification curve with low slope and C;
values higher than expected

The amplification curve has a low slope and the amplification reaction may not reach
the plateau phase. HRM resolution may be affected by the lower increase in
fluorescence.

Delta Rn vs Cycle
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Cycle Number
Possible causes Recommended action
DNA sample contains contaminants that inhibit PCR. Dilute the samples 1:10 or 1:100, then repeat the HRM
reactions.
Incorrect salt concentration. Perform a MgCl, titration to find the optimal salt
concentration for each reaction.
Reaction does not contain sufficient enzyme. Optimize the reaction using the MeltDoctor™ HRM
Reagents (see page 93 for reaction component volumes).
You can add up to 0.15 U/uL AmpliTag Gold® 360 DNA
Polymerase to each reaction.
Reaction does not contain sufficient primer. Optimize the reaction using the MeltDoctor™ HRM
Reagents (see page 93 for reaction component volumes).
You can add up to 0.5 uyM of each primer to each reaction.
Amplicon is greater than 200 bp. Increase the extension times during the amplification
reaction.
Primers are amplifying multiple targets. Perform a BLAST search to ensure primer specificity. If the

primers are not specific, design new primers.

Reduce the number of amplification cycles.
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Nonspecific amplification: Decreased PCR efficiency and multiple amplicons

Nonspecific amplification: Decreased PCR efficiency and
multiple amplicons

Decreased PCR efficiency and multiple amplicons may affect the melting behavior of
the true target amplicons.

Possible causes Recommended action

Incorrect salt concentration. Perform a MgCl, titration to find the optimal salt
concentration for each reaction.

Primers are amplifying multiple targets. Perform a BLAST search to ensure primer specificity. If the
primers are not specific, design new primers.

Reduce the number of amplification cycles.

After PCR amplification, consider running some of the PCR
product on a gel to make sure that it contains a single
band.
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Chapter 6  Troubleshooting HRM Experiments
Replicates are widely spread: Sample replicates show a wide spread in HRM curves

Replicates are widely spread: Sample replicates show a wide
spread in HRM curves

A wide spread within a population leads to difficulties in assessing true sequence
differences, particularly between two different homozygous populations.

Possible causes Recommended action

Population spread Use multiple controls for HRM analysis to help you define
the population spread.

Incorrect salt concentration. Perform a MgCl, titration to find the optimal salt
concentration for each reaction.

Note: For some nucleic acid extraction kits, the elution
buffer contains high salt concentrations.

DNA starting concentrations vary widely between samples. | Make sure that the starting DNA concentrations are similar
for the samples that you are testing.

Low PCR efficiencies. Ensure efficient PCR.

Multiple melt regions: Complex melt curves with multiple
melting regions

Complex melt curves are difficult to interpret. If the amplicon is too long, the melt
curve may have multiple melt regions because of the regional sequence context of the

amplicon.
Possible causes Recommended action
The amplicon contains more than one SNP (genotyping Sequence the PCR product to confirm whether the
experiments only). amplicon contains more than 1 SNP. If the sequencing
reveals more SNPs, redesign the primers so that the
amplicon contains only 1 SNP.
The amplicon is too long. Redesign the primers to reduce the amplicon size.
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More than three different variant calls (HRM genotyping experiments only)

More than three different variant calls (HRM genotyping
experiments only)

If the target contains unknown SNPs, multiple heterozygous and homozygous
amplicons can be produced. If the amplicon is too long, the melt curve may have
multiple melt regions even without a SNP because of the regional sequence context of
the amplicon.

Possible causes Recommended action

The amplicon contains more than 1 SNP. Sequence the PCR product to confirm whether the
amplicon contains more than 1 SNP. If the sequencing
reveals more SNPs, redesign the primers so that the
amplicon contains only 1 SNP.

The amplicon is too long. Redesign the primers to reduce the amplicon size.

Messy HRM curves: Diagonal wavy curves below heterozygous
clusters

HRM data from negative controls and unamplified samples skew the pre- and post-
melt curve settings and interfere with the variant calls.

Possible cause Recommended action
Negative controls and unamplified samples are included in | ¢ Assign negative controls to the experiment in the
the HRM analysis. instrument software before you open them with the
HRM Software.
or

e Omit negative controls and unamplified samples from
the HRM analysis. Refer to the High Resolution Melt
Software Help System.
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Appendix A

Ordering Information

Materials and equipment for HRM calibration and HRM

experiments

MeltDoctor™ HRM
reagents

Equipment and
software

Item

Applied Biosystems

Part Number

MeltDoctor™ HRM Calibration Plate, Fast 96-Well 4425618
MeltDoctor™ HRM Calibration Standard (20X), 1 mL 4425562
MeltDoctor™ HRM Master Mix, 5 mL bottle 4415440
MeltDoctor™ HRM Master Mix, 5 x 5 mL bottle 4415452
MeltDoctor™ HRM Master Mix, 10 x 5 mL bottle 4415450
MeltDoctor™ HRM Master Mix, 50 mL bottle 4409535
MeltDoctor™ HRM Positive Control Kit: 4410126
¢ MeltDoctor™ HRM Allele A DNA (20X), 150 pL
e MeltDoctor™ HRM Allele G DNA (20X), 150 pL
e MeltDoctor™ HRM Allele A/G DNA (20X), 150 pL
¢ MeltDoctor™ HRM Primer Mix (20X), 500 pL
MeltDoctor™ HRM Reagents: 4425557
¢ AmpliTag Gold® 360 DNA Polymerase
¢ AmpliTag Gold® 360 Buffer
e 360 GC Enhancer
¢ GeneAmp® dNTP Blend
¢ MeltDoctor™ HRM Dye (20X)

Item Source

StepOne™ Real-Time PCR System:

StepOne™ Real-Time PCR System:
StepOne™ Real-Time PCR System with Tower
StepOne™ Real-Time PCR System with Laptop

Applied Biosystems
e PN 4376357
e PN 4376374
e PN 4376373

StepOnePlus™ Real-Time PCR System:

StepOnePlus™ Real-Time PCR System
StepOnePlus™ Real-Time PCR System with Tower
StepOnePlus™ Real-Time PCR System with Laptop

7500 Fast Real-Time PCR System:

e 7500 Fast Real-Time PCR System with Notebook Computer
e 7500 Fast Real-Time PCR System with Tower Computer

Applied Biosystems
e PN 4376600
e PN 4376599
e PN 4376598

Applied Biosystems

e PN 4351106
e PN 4351107
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Materials for bisulfite conversion

Item Source
High Resolution Melt Software v3.0: Applied Biosystems
e 1 license e PN 4461357
¢ 10 licenses e PN 4461456
Primer Express® Software v3.0 or later Applied Biosystems
Centrifuge with plate adapters Major laboratory

suppliers (MLS)
Lab equipment MLS
Microcentrifuge MLS
Microcentrifuge tubes MLS
Pipettors and pipette tips MLS
Vortexer MLS
Supplies

Item Source
Appropriate reaction plate for your instrument: Applied Biosystems
¢ MicroAmp® Fast Optical 96-Well Reaction Plate with e PN 4346906 and

Barcode, 0.1 mL 4366932

e MicroAmp® Fast Optical 48-Well Reaction Plate e PN 4375816
MicroAmp® Optical Adhesive Film: Applied Biosystems
e 25 films e PN 4360954
e 100 films e PN 4311971
MicroAmp® 48-Well Optical Adhesive Film: Applied Biosystems
e 25 films e PN 4375928
e 100 films e PN 4375323
Microcentrifuge tubes MLS
Pipettors and pipette tips MLS

Materials for bisulfite conversion

Item Source

Cells-to-CpG™ Bisulfite Conversion Kit (2x96) Applied Biosystems
PN 4445554

Cells-to-CpG™ Bisulfite Conversion Kit (50) Applied Biosystems
PN 4445555

Cells-to-CpG™ Bisulfite Conversion and Quantitation Control Kit Applied Biosystems
PN 4445553

Cells-to-CpG™ Methylated and Unmethylated gDNA Control Kit Applied Biosystems
PN 4445552
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Appendix A Ordering Information
Materials and equipment for sequencing variants after HRM analysis

Materials and equipment for sequencing variants after HRM

analysis

Equipment

Supplies

Reagents

Item

Source

Applied Biosystems DNA sequencer:

¢ Applied Biosystems 3500/3500x/ DNA Analyzer
¢ Applied Biosystems 3730/3730x/ DNA Analyzer
e Applied Biosystems 3130/3130x/ DNA Analyzer
e Applied Biosystems 3100/3100-Avant DNA Analyzer

Veriti® 96-Well Fast Thermal Cycler
Centrifuge with plate adapters
Microcentrifuge

Vortexer

Applied Biosystems

Applied Biosystems
MLS
MLS
MLS

Item

Source

MicroAmp® Clear Adhesive Film, 100 films

MicroAmp® Optical Film Compression Pad
Wide-bore (>1 mm) pipette tips:

e Wide-Orifice Tips

e (Clear Wide Bore Tips

Microcentrifuge tubes

Pipettors and pipette tips

Applied Biosystems
PN 4306311

Applied Biosystems

e Rainin Instrument LLC
¢ Axygen Scientific Inc.

MLS
MLS

For the SDS of any chemical not distributed by Life Technologies, contact the chemical
manufacturer. Before handling any chemicals, refer to the SDS provided by the

manufacturer, and observe all relevant precautions.

Item

Source

BigDye® Terminator v1.1 Cycle Sequencing Kit, 100 reactions

BigDye XTerminator® Purification Kit, 2 mL (~100 20-pL
reactions)

M13 forward and reverse sequencing primers:
e M13 Forward (-20), 2 pg
e M13 Reverse, 2 ug

Note: Use only if the HRM PCR product contains the M13
sequences.

Applied Biosystems
PN 4337450

Applied Biosystems
PN 4376486

Invitrogen

* PN N520-02
e PN N530-02

UltraPure™ DNase/RNase-Free Distilled Water, 500 mL

Invitrogen PN 10977-015

ExoSAP-IT®, 100 reactions USB Corporation
PN 78200
Deionized Water MLS
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Appendix B

Supplemental Information and
Procedures

This appendix contains supplemental information and procedures for preparing and
running HRM reactions and for using the High Resolution Melt Software v3.0.

B About HRMdAyes ... e e 89
B Calibrate your instrument using other HRM dyes ....................... 89
B Prepare your own HRM calibrationplate.............................. 90
B Preparethe DNA templates ..., 91
B Order CUSTOM PIIMETS . o . o\ttt et et et et anas 92
B Optimizing the reaction conditions. .. .............viiininrnenene.... 93
B Computer FeqUITCMENTS. . . . o vttt ettt ettt e anas 94
B Change the HRM calibrationfile .. ............. ... ... ... ... ..... 95
B Guidelines for experiments with multiple HRM assays................... 96
B Publishingthedata ......... ... . . . . i 96

About HRM dyes

The melting profile of a PCR product is best obtained with high-resolution melting
dyes (HRM dyes). HRM dyes are double-stranded DNA(dsDNA)-binding dyes that
have high fluorescence when bound to dsDNA and low fluorescence in the unbound
state. HRM analysis uses dsDNA-binding dyes that are brighter than those previously
used, and they do not inhibit PCR at high-dye concentrations. With traditional dyes (for
example, SYBR® Green I dye), only limited concentrations of the dye can be used
before the dye inhibits the PCR (Kent et al., 2007).

Calibrate your instrument using other HRM dyes

For each HRM dye that you plan to use in HRM experiments, you need to first calibrate
your instrument for that HRM dye. If you choose to use a dye other than the
MeltDoctor™ HRM Dye, follow this workflow to calibrate your instrument:

1. Perform a background calibration. Follow the instructions on page 10.
a. Prepare the background calibration plate.
b. Run the background calibration plate.

c. Review the background calibration results.
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Prepare your own HRM calibration plate

E Appendix B Supplemental Information and Procedures

2. Amplify the DNA in the HRM calibration plate.

a. Prepare the calibration plate — Prepare your own HRM calibration plate using
the MeltDoctor” HRM Calibration Standard with your dye and your own
master mix.

b. Run your HRM calibration plate to amplify the DNA.

c. Verify that the HRM calibration samples amplified — Use the instructions on
page 13 as guidelines.

3. Calibrate the instrument to use your HRM dye.

a. Run the HRM calibration plate for the custom dye calibration — Use the
instructions on page 13 as guidelines.

b. Review the custom dye calibration results — Use the instructions on page 14
as guidelines.

4. Perform a melt curve to generate the HRM calibration file.
a. Run the HRM calibration plate for the HRM calibration.

b. Verify that the Melt Curve contains only one Tm peak — Use the instructions
on page 16 as guidelines.

You should also optimize your reactions for the HRM dye that you choose, because
each dye interacts uniquely with all other reaction components, affecting the sensitivity
of the analysis.

Prepare your own HRM calibration plate

This procedure is for preparing your own HRM calibration plate using the
MeltDoctor™ HRM Master Mix and MeltDoctor” HRM Calibration Standard.

IMPORTANT! The HRM calibration plate should be prepared fresh and used
immediately. It is important to perform the amplification run, custom dye calibration,
and HRM calibration on the same day that the HRM calibration plate is prepared.

Note: If you are using the MeltDoctor’" HRM Reagents instead of the MeltDoctor ™™
HRM Master Mix, use the same component volumes in the HRM calibration plate that
you are using in your HRM reactions.

If you are using a different HRM dye, prepare your HRM calibration plate using the
MeltDoctor™ HRM Calibration Standard with your dye and your own master mix.
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Prepare the DNA templates

1. Add the required volumes of each component to an appropriately sized tube:
Volume (pL)
Component
1 reaction 55 reactions 110 reactions

MeltDoctor™ HRM Master Mix 10 550 1100
MeltDoctor™ HRM Calibration 1 55 110
Standard (20X)
Deionized water 9 495 990

Total volume 20 1100 2200

Cap the tube, then vortex to mix.
Spin the tube briefly.

Pipet the HRM calibration reactions to each well of an appropriate reaction plate
for your instrument.

IMPORTANT! Accurate pipetting is required for proper calibration.

Inspect the plate to make sure all wells contain liquid.

IMPORTANT! Empty wells may cause the calibration to fail.

Seal the reaction plate with optical adhesive film, then spin the reaction plate.

Prepare the DNA templates

1.

Purify all the DNA samples in an HRM experiment using the same method. Watch
out for salt carryover because it will subtly change the thermodynamics of the
DNA melting transition.

Perform agarose gel electrophoresis and spectrophotometry to make sure the DNA
template is intact and is not contaminated with other DNAs, RNAs, proteins, or
organic chemicals. Proteins and organic chemicals may inhibit the PCR
amplification, and contaminating DNAs and RNAs may result in sub-optimal
PCR performance or increased change of non-specific amplification.

Determine the quantity of DNA using spectrophotometry. If too little DNA
template is added to the reaction, the fluorescence signal may not be sufficient for
successful HRM analysis. If too much DNA template is added to the reaction, the
PCR may be inhibited.

4. (Optional) Dilute the DNA to 20 ng/uL.
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Order custom primers

1. Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user.

2. Below the Custom Primers & Probes heading, click Custom Unlabeled Primers,
then click Sequence Detection Primers.

3. In the Ordering Information tab, select the check box next to the quantity of
primers to order, then click Configure.

4. Follow the instructions on the web page to configure the primers:
a. Select purification and formulation options.
b. Enter or upload the primer names and sequences.

c. Review the oligos to order.

Note: If any of the oligos are invalid, follow the instructions on the web page
to edit the sequence information.

5. Click Add to Basket.

6. Follow the link to your Shopping Basket, then follow the instructions on the web
page to place your order.
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Appendix B Supplemental Information and Procedures
Optimizing the reaction conditions

Optimizing the reaction conditions

If you want to optimize the reaction conditions, use the MeltDoctor” HRM Reagents.
See Table 1 for the recommended reaction component volumes.

For more information on optimizing your HRM reactions, refer to 4 Guide to High
Resolution Melting (HRM) Analysis (Stock number O-081740 0509).

Table 1 Recommended reaction component volumes using the MeltDoctor™

HRM Reagents

Components \(I)c:: T(?—Iﬁ.r \(I)c:: r;g_::ir Final cc::;g;:tration
reaction reaction

AmpliTaq Gold® 360 Buffer, 10X 1L 2 uL 1X
25 mM Magnesium Chloride 0.6t0 0.9 uL 1.2t01.8 uL 1.5t03.5mM
GeneAmp® dNTP Blend, 10 mM 0.1t0 0.3 L 0.210 0.6 pL 100 to 300 pM each
Primer 1 (5 pM) 0.4t01.0uL 0.8t0 2.0 uL 0.2t0 0.5 uM
Primer 2 (5 pM) 0.41t01.0 L 0.8t02.0 L 0.2 t0 0.5 yM
MeltDoctor™ HRM Dye (20X) 0.5 L 1.0 uL 1X
AmpliTaq Gold® 360 DNA 0.1t0 0.3 pL 0.2t0 0.6 pL 0.05 to 0.15 U/uL
Polymerase (5 U/pL)
Human gDNA (20 ng/pL) 0.5 L 1L 10 pg/pL to 10 ng/pL
Deionized water As needed As needed -
Total volume 10 L 20 yL -
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Computer requirements

Computer requirements

The hardware and software requirements for running HRM Software are listed in the

table below.
Component Recommended Requirements Minimum Requirements*
Computer ¢ Intel® Core™ 2 Duo processor or compatible ¢ Intel® Pentium® 4 processor or compatible
processor, 2.4 GHz processor, 1.2 GHz
e 4GB of RAM e 1GB of RAM
¢ One hard drive with 60 GB available$ ¢ One hard drive with 10 GB available
e 20/48X IDE CD-ROM* e 20/48X IDE CD-ROM*
e USBv2.0 e USBv1.1
e Ethernet network interface adapter (10BASE-T) | e Ethernet network interface adapter (10BASE-T)
e UL listed e UL listed
e CE marked e CE marked
¢ FCC labeled ¢ FCC labeled
Monitor e 1280 x 1024 pixel resolution for full screen e 1280 x 1024 pixel resolution for full screen
display display
e 16-inch color monitor e 16-inch color monitor
e 32-bit color e 32-bit color
e UL listed e UL listed
Operating Microsoft® Windows® XP Operating System, Microsoft® Windows® XP Operating System,
System Service Pack 3 or greater Service Pack 2 or greater

I The Minimum Requirements column lists the lowest specifications that permit the installer to install the software. The minimum requirements

may not provide optimal performance. Life Technologies does not guarantee support of an installation in this environment.
§ For optimal performance of the software, partition the hard drives on your computer.

# Not necessary if downloading the software from www.appliedbiosystems.com.
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Change the HRM calibration file

Change the HRM calibration file

View the HRM
calibration file

Change (overwrite)
the HRM calibration
file

Change the default
HRM calibration file

IMPORTANT! The HRM calibration file must be:
* Run on the same instrument as the run file
* Run in the same reaction plate type as the run file (96-well Fast or 48-well Fast)
* Run with the same software version as the run file

* Run using the same run conditions (the same ramp mode and ramp increment) as
the run file

Open the Experiment Properties screen to view the name of the calibration file that is
assigned to the HRM experiment file.

You can change (overwrite) the HRM calibration file just for the HRM experiment that
you are viewing.

1. In the menu bar, select Analysis » Change Calibration File.

2. Browse to and select the appropriate HRM calibration file (*.eds file), then click
OK.

This option changes the default HRM calibration file for all subsequent new HRM
experiments run on a particular instrument.

1. From the menu bar, select Analysis » Select Default Calibration File.

2. Select the appropriate instrument from the dropdown menu, then browse to and
select the appropriate HRM calibration file (*.eds file), then click OK.

Note: If you change the default calibration file, it changes the calibration file only
for subsequent new HRM experiments for that instrument type. Changing the
default calibration file does not change the calibration file for previously analyzed
experiments.
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Guidelines for experiments with multiple HRM assays

In the HRM Software, an assay is defined as a specific combination of target and dye.
You can have multiple assays in the same plate, and the HRM Software analyzes each
assay separately, using distinct analysis settings.

If your reaction plate contains multiple HRM assays, make sure that you:

* Assign a different target for each HRM assay in the instrument software before
you open the file with the HRM Software. The HRM Software analyzes data for
each target separately.

» Select the assay from the Assay dropdown menu before you review the results or
make any changes to the HRM experiment file.

Publishing the data

You can publish the data from the HRM Software in several ways:

Icon Icon location Action

;ﬁ_—l Toolbar Export data.

@ Toolbar Create slides.

E4 Print Report. .. Toolbar Print a report.

NA NA Copy and paste data from the well table to a text or
spreadsheet application.

o Plot Copy and paste the plot to a text, spreadsheet, or

I._I .

slide.

|-:EL| Plot Print a plot.

.|_[g| Plot Save a plot as an image file.

For information on performing these procedures, click (2 or press F1 in the HRM
Software to access the Help system.
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Software Warranty Information

Computer configuration

Applied Biosystems supplies or recommends certain configurations of computer
hardware, software, and peripherals for use with its instrumentation.

Applied Biosystems reserves the right to decline support for or impose extra charges
for supporting nonstandard computer configurations or components that have not been
supplied or recommended by Applied Biosystems. Applied Biosystems also reserves
the right to require that computer hardware and software be restored to the standard
configuration prior to providing service or technical support. For systems that have
built-in computers or processing units, installing unauthorized hardware or software
may void the Warranty or Service Plan.

Third party products

This Software uses third-party software components from several sources. Portions of
these software components are copyrighted and licensed by their respective owners.
Various components require distribution of source code or if a URL is used to point the
end-user to a source-code repository, and the source code is not available at such site,
the distributor must, for a time determined by the license, offer to provide the source
code. In such cases, please contact your Applied Biosystems representative. As well,
various licenses require that the end-user receive a copy of the license. Such licenses
may be found in an Appendix of the Users Guide. In order to use this Software, the
end-user must abide by the terms and conditions of these third-party licenses.

Limited product warranty

Limited warranty

Applied Biosystems warrants that for a period of ninety days from the beginning of the
applicable warranty period (as described below) the Software will function
substantially in accordance with the functions and features described in the
Documentation delivered with the Software when properly installed, and that for a
period of ninety days from the beginning of the applicable warranty period (as
described below) the tapes, CDs, diskettes or other media bearing the Software will be
free of defects in materials and workmanship under normal use.

The above warranties do not apply to defects resulting from misuse, neglect, or
accident, including without limitation: operation outside of the environmental or use
specifications, or not in conformance with the instructions for any instrument system,
software, or accessories; improper or inadequate maintenance by the user; installation
of software or interfacing, or use in combination with software or products not supplied
or authorized by Applied Biosystems; and modification or repair of the products not
authorized by Applied Biosystems.
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Limited product warranty

Warranty period
commencement
date

Warranty claims

Warranty
exceptions

Warranty limitations

The applicable warranty period for software begins on the earlier of the date of
installation or three (3) months from the date of shipment for software installed by
Applied Biosystems’ personnel. For software installed by the purchaser or anyone
other than Applied Biosystems, the warranty period begins on the date the software is
delivered to you. The applicable warranty period for media begin on the date the media
is delivered to the purchaser.

Warranty claims must be made within the applicable warranty period.

The above warranties do not apply to defects resulting from misuse, neglect, or
accident, including without limitation: operation outside of the environmental or use
specifications, or not in conformance with the instructions for the instrument system,
software, or accessories; improper or inadequate maintenance by the user; installation
of software or interfacing, or use in combination with software or products, not
supplied or authorized by Applied Biosystems; and modification or repair of the
product not authorized by Applied Biosystems.

The foregoing provisions set forth Applied Biosystems' sole and exclusive
representations, warranties, and obligations with respect to its products, and

Applied Biosystems makes no other warranty of any kind whatsoever, expressed or
implied, including without limitation, warranties of merchantability and fitness for a
particular purpose, whether arising from a statute or otherwise in law or from a course
of dealing or usage of trade, all of which are expressly disclaimed.

APPLIED BIOSYSTEMS MAKES NO OTHER WARRANTIES OF ANY KIND
WHATSOEVER, EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE
OR DOCUMENTATION, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
FITNESS FOR A PARTICULAR PURPOSE OR MERCHANTABILITY OR THAT
THE SOFTWARE OR DOCUMENTATION IS NON-INFRINGING. ALL OTHER
WARRANTIES ARE EXPRESSLY DISCLAIMED. WITHOUT LIMITING THE
GENERALITY OF THE FOREGOING, APPLIED BIOSYSTEMS MAKES NO
WARRANTIES THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS,
THAT OPERATION OF THE LICENSED SOFTWARE WILL BE
UNINTERRUPTED OR ERROR FREE OR WILL CONFORM EXACTLY TO THE
DOCUMENTATION, OR THAT APPLIED BIOSYSTEMS WILL CORRECT ALL
PROGRAM ERRORS. APPLIED BIOSYSTEMS’ SOLE LIABILITY AND
RESPONSIBILITY FOR BREACH OF WARRANTY RELATING TO THE
SOFTWARE OR DOCUMENTATION SHALL BE LIMITED, AT APPLIED
BIOSYSTEMS’ SOLE OPTION, TO (1) CORRECTION OF ANY ERROR
IDENTIFIED TO APPLIED BIOSYSTEMS IN A WRITING FROM YOU IN A
SUBSEQUENT RELEASE OF THE SOFTWARE, WHICH SHALL BE SUPPLIED
TO YOU FREE OF CHARGE, (2) ACCEPTING A RETURN OF THE PRODUCT,
AND REFUNDING THE PURCHASE PRICE UPON RETURN OF THE PRODUCT
AND REMOVAL OF ALL COPIES OF THE SOFTWARE FROM YOUR
COMPUTERS AND STORAGE DEVICES, (3) REPLACEMENT OF THE
DEFECTIVE SOFTWARE WITH A FUNCTIONALLY EQUIVALENT PROGRAM
AT NO CHARGE TO YOU, OR (4) PROVIDING A REASONABLE WORK
AROUND WITHIN A REASONABLE TIME. APPLIED BIOSYSTEMS SOLE
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Limited product warranty

LIABILITY AND RESPONSIBILITY UNDER THIS AGREEMENT FOR BREACH
OF WARRANTY RELATING TO MEDIA IS THE REPLACEMENT OF
DEFECTIVE MEDIA RETURNED WITHIN 90 DAYS OF THE DELIVERY DATE.
THESE ARE YOUR SOLE AND EXCLUSIVE REMEDIES FOR ANY BREACH OF
WARRANTY. WARRANTY CLAIMS MUST BE MADE WITHIN THE
APPLICABLE WARRANTY PERIOD.

Limitation of IN NO EVENT SHALL APPLIED BIOSYSTEMS OR ITS SUPPLIERS BE
liability RESPONSIBLE OR LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY

OR UNDER ANY STATUTE (INCLUDING WITHOUT LIMITATION ANY
TRADE PRACTICE, UNFAIR COMPETITION OR OTHER STATUTE OF
SIMILAR IMPORT) OR ON ANY OTHER BASIS FOR SPECIAL, INDIRECT,
INCIDENTAL, MULTIPLE, PUNITIVE, OR CONSEQUENTIAL DAMAGES
ARISING OUT OF THE POSSESSION OR USE OF, OR THE INABILITY TO USE,
THE SOFTWARE OR DOCUMENTATION, EVEN IF APPLIED BIOSYSTEMS IS
ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH DAMAGES,
INCLUDING WITHOUT LIMITATION DAMAGES ARISING FROM OR
RELATED TO LOSS OF USE, LOSS OF DATA, DOWNTIME, OR FOR LOSS OF
REVENUE, PROFITS, GOODWILL OR BUSINESS OR OTHER FINANCIAL
LOSS. IN ANY CASE, THE ENTIRE LIABILITY OF APPLIED BIOSYSTEMS’
AND ITS SUPPLIERS UNDER THIS LICENSE, OR ARISING OUT OF THE USE
OF THE SOFTWARE, SHALL NOT EXCEED IN THE AGGREGATE THE
PURCHASE PRICE OF THE PRODUCT.

SOME STATES, COUNTRIES OR JURISDICTIONS LIMIT THE SCOPE OF OR
PRECLUDE LIMITATIONS OR EXCLUSION OF REMEDIES OR DAMAGES, OR
OF LIABILITY, SUCH AS LIABILITY FOR GROSS NEGLIGENCE OR WILLFUL
MISCONDUCT, AS OR TO THE EXTENT SET FORTH ABOVE, OR DO NOT
ALLOW IMPLIED WARRANTIES TO BE EXCLUDED. IN SUCH STATES,
COUNTRIES OR JURISDICTIONS, THE LIMITATION OR EXCLUSION OF
WARRANTIES, REMEDIES, DAMAGES OR LIABILITY SET FORTH ABOVE
MAY NOT APPLY TO YOU. HOWEVER, ALTHOUGH THEY SHALL NOT APPLY
TO THE EXTENT PROHIBITED BY LAW, THEY SHALL APPLY TO THE
FULLEST EXTENT PERMITTED BY LAW. YOU MAY ALSO HAVE OTHER
RIGHTS THAT VARY BY STATE, COUNTRY OR OTHER JURISDICTION.
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Appendix D

Safety

This appendix covers:

B General chemicalsafety . ........... .. .. .. .. .. .. .. . 101
B S SS it 101
B Biological hazardsafety . ........... .. ... ... . . . 102

General chemical safety

Chemical hazard C WARNING! CHEMICAL HAZARD. Before handling any chemicals,
warning refer to the Safety Data Sheet (SDS) provided by the manufacturer, and
observe all relevant precautions.

Chemical safety To minimize the hazards of chemicals:

ideli . .
guidelines Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. (See “About SDSs” on page 101.)

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the SDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the SDS.

* Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

SDSs

About SDSs  Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments of
hazardous chemicals to new customers. They also provide SDSs with the first shipment
of a hazardous chemical to a customer after an SDS has been updated. SDSs provide
the safety information you need to store, handle, transport, and dispose of the
chemicals safely.

Each time you receive a new SDS packaged with a hazardous chemical, be sure to
replace the appropriate SDS in your files.
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Biological hazard safety

Obtaining The SDS for any chemical supplied by Applied Biosystems is available to you free 24
SDSs  hours a day. To obtain SDSs:

1. Go to www.appliedbiosystems.com, click Support, then select SDS.

2. In the Keyword Search field, enter the chemical name, product name, SDS part
number, or other information that appears in the SDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:

*  Open — To view the document
* Print Target — To print the document

» Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the SDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

Biological hazard safety

General biohazard & WARNING! BIOHAZARD. Biological samples such as tissues, body

fluids, infectious agents, and blood of humans and other animals have the
potential to transmit infectious diseases. Follow all applicable local,
state/provincial, and/or national regulations. Wear appropriate protective
equipment, which includes but is not limited to: protective eyewear, face shield,
clothing/lab coat, and gloves. All work should be conducted in properly
equipped facilities using the appropriate safety equipment (for example,
physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines
and/or regulatory requirements in the following:

» U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (stock no. 017-
040-00547-4; www.cdc.gov/biosafety/publications/index.htm)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html).

* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov
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Documentation and Support

Related documentation

HRM  The following documents about HRM experiments are available:

documentation * High Resolution Melt Software Help — Installed with and accessible from within

the HRM Software, the Help system describes the software and provides
procedures for common tasks.

* Quick reference cards provide abbreviated procedures for performing HRM
experiments using MeltDoctor"” HRM Reagents and HRM Software:

— HRM Genotyping Quick Reference Card (PN 4457857)
—  HRM Mutation Scanning Quick Reference Card (PN 4457855)
— HRM Methylation Studies Quick Reference Card (PN 4457856)

* A Guide to High Resolution Melting (HRM) Analysis (Stock number O-081740) —
This document provides background information on HRM analysis to help you
perform robust HRM experiments.

Access the HRM  To access the High Resolution Melt Software Help System from within the HRM
Help system  Software, click € in the software window, select Help » High Resolution Melt
Software Help, or press F1.

7500 Fast, The following related documents are available from Applied Biosystems:
StepOne , and

™
StepOnSe PI;JS Instrument and Document Part
documen¥:tﬁ)mn software number
7500 Fast System and Applied Biosystems 7500/7500 Fast Real-Time 4387777
7500 Software v2.0 or PCR System Maintenance Guide
lat ; .
ater Applied Biosystems 7500 Software v2.0 Help NA
StepOne™ and Applied Biosystems StepOne™ and 4376782
StepOnePlus™ Systems  StepOnePlus™ Real-Time PCR Systems
and StepOne Software Installation, Networking, and Maintenance Guide
v2.2 or later Applied Biosystems StepOne™ Software Help NA

How to obtain support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:

* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.
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Documentation and Support
How to obtain support

* Search through frequently asked questions (FAQs).
» Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, SDSs, certificates of analysis, and
other related documents.

* Download PDF documents.
* Obtain information about customer training.

* Download software updates and patches.
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aligned melt curves
plot

amplicon

Analysis Settings
library

control

Control Library

derivative melt curve
plot

difference plot

dissociation curve

Dye Library

experiment file

export

Glossary

In HRM experiments, a plot of the aligned fluorescence (0-100%) over temperature
( °C). The melt curves have been aligned to the same fluorescence level using the pre-
and post-melt regions set in the HRM Settings tab.

A segment of DNA amplified during PCR.

In the software, a collection of analysis settings to use in experiments. You can save
settings and reuse them. You cannot edit or import settings into the library.

In HRM experiments, a sample of known genotype or melt-curve shape. When you
assign controls, you can:

¢ Assign multiple controls for each cluster to more effectively define the natural
spread or variation that is present within different samples of the same sequence,
or replicates of the same genotype.

* Assign as many controls as appropriate for the type of HRM experiment that you
are performing.

In the software, an editable collection of controls to use in HRM experiments. The
controls in the library contain the control name and control color and, optionally,
comments about the control.

The default view of the melting curve. It plots the negative derivative data (-Rn” ) vs.
temperature ( °C) for high resolution melt curve experiments.

In HRM experiments, a plot of the aligned data as the difference in fluorescence
between the reference curve and the other melt (dissociation) curves. After you select
the reference curve, the software subtracts the reference curve from the other curves.

See melt curve.

In the software, a collection of dyes to use in experiments. Custom dyes can be added
to the library, but system dyes cannot be removed.

An electronic record that contains all information about a particular plate, including
metadata (name, barcode, comments), plate setup (well contents, assay definitions),
run method (thermal cycling profile), run results, analysis settings, analysis results,
and other plate-specific data. Experiment files have the suffixes *.eds (experiment
document single), *.edt (template), and *.edm (multiple.)

A software feature that allows you to export experiment setup files, experiment
results, instrument information, and analysis results to spreadsheet, presentation, or
text files. You can edit the default location of the exported file.
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Glossary

forward primer

heterozygote
high resolution
melting (HRM)
experiment

homozygote

HRM calibration

import

melt curve

melt curve
characteristics

melting temperature
(Tm)

melting transition
region

negative control (NC)

no template control
(NTC)

omit well

outlier

108

Oligonucleotide that flanks the 5" end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

Samples having both allele 1 and allele 2.

An experiment that generates and analyzes high-resolution melt curves from an HRM
reaction.

Samples having only allele 1 or only allele 2.

Type of calibration in which the instrument is calibrated to accommodate MeltDoctor™

HRM Dye or custom dyes for analysis of HRM experiments.

A software feature that allows you to import plate setup information before
performing an HRM analysis. You can also import information into some libraries in
the system.

A plot of data collected during the melt curve stage. Peaks in the melt curve can
indicate the melting temperature (Tm) of the target, or they can identify nonspecific
PCR amplification. In the software, you can view the melt curve as normalized
reporter (Rn) vs. temperature or as derivative reporter (-Rn” ) vs. temperature. In a high
resolution melting experiment, you can view the melt curve as fluorescence vs.
temperature. Also called dissociation curve.

The melt curve shape and the difference in melting temperature (Tm) values.

The temperature at which 50% of the DNA is double-stranded and 50% of the DNA is
dissociated into single-stranded DNA. The Tm is displayed in the melt curve.

In melt curve experiments, the region before and after the melting temperature (Tm).

In the software, the task for targets in wells that contain water or buffer instead of
sample. No amplification of the target should occur in negative control wells. Negative
controls are needed to control as amplification controls, but they are not appropriate
for HRM analysis. HRM Software automatically omits wells from the HRM analysis if
the wells contain a negative control task. Previously called no template control (NTC).

See negative control (NC).
An action that you perform before reanalysis to omit one or more wells from analysis.

Because no algorithms are applied to omitted wells, omitted wells contain no results.
You can add wells back to the analysis; no information is permanently discarded.

A measurement that deviates significantly from the measurement of the other
replicates for that same sample.
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passive reference

plate layout

plate setup file

positive control

primer mix

Real-time PCR Data
Markup Language
(RDML)

reference

reject well

replicate group

replicates

reporter

reverse primer

sample

sample definition file

Glossary

A dye that produces fluorescence signal independent of PCR amplification, and that is
added to each reaction at a constant concentration. Because the passive reference
signal should be consistent across all wells, it is used to normalize the reporter dye
signal to account for non-PCR related fluorescence fluctuations caused by minor well-
to-well differences in volume. Normalization to the passive reference signal generally
results in data with noticeably high precision among technical replicates.

An illustration of the grid of wells and assigned content in the reaction plate. The
number of rows and columns in the grid depends on the sample block that you use.

In the software, you can use the plate layout as a selection tool to assign well contents,
to view well assignments, and to view results. The plate layout can be printed,
included in a report, exported, and saved as a slide for a presentation.

A file (*.txt, *.csv, *.xml, *.sds, or *.sdt) that contains setup information such as the well
number, sample name, sample color, target name, dyes, and other reaction plate
contents.

A DNA sample with a known variant call.

PCR reaction component that contains the forward primer and reverse primer
designed to amplify the target.

A reporting format that is compliant with the Minimum Information for Publication
for Quantitative Real Time Experiments (MIQE) guidelines (http://www.rdml.org).

In an HRM experiment, the melt curve selected by a user in the difference plot to use
as a basis for comparison. The software displays the aligned data as the difference in
fluorescence between the reference curve and the other melt curves.

An action that the software performs during analysis to remove one or more wells
from further analysis if a specific flag is applied to the well. Rejected wells contain
results calculated up to the point of rejection.

A user-defined biological grouping. A replicate group may be a set of identical
reactions in an experiment.

Total number of identical reactions containing identical components and volumes.

A fluorescent dye used to detect amplification. With MeltDoctor'' HRM Reagents, the
reporter dye is MeltDoctor" HRM Dye, a DNA-binding dye.

An oligonucleotide that flanks the 3 end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

The template that you are testing for a target gene.

A tab-delimited file (*.txt or *.csv) that contains the following setup information: well
number, sample name, and custom sample properties.
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Sample Library

silhouette score

target

target color

Target Library

task

template

thermal profile

Tm

unknown

variant
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In the software, an editable collection of samples to use in experiments. The samples in
the library contain the sample name and sample color, and, optionally, comments
about the sample.

A measure of the distinguishability of a melt curve relative to other melt curves in the
assay (Rousseeuw, 1987). For each melt curve, the HRM Software assigns a modified
silhouette score, a value that ranges from 0 to 1. Note that for standard silhouette
scores (Lovmar, et al., 2005), the score is assigned to each identified cluster instead of to
each data point in the cluster and the value ranges from -1 to 1.

In the HRM Software, you can find the score in the Silhouette Score column of the Well
Table on an Analysis screen. Silhouette scores close to 1.0 (0.8 to 1.0) are desirable and
indicate that a melt curve is more similar to melt curves that were assigned the same
variant call than to melt curves that were assigned different variant calls. Lower
silhouette scores indicate that the melt curve is less similar to melt curves that were
assigned the same variant call.

The nucleic acid sequence to amplify and detect.

In the software, a color assigned to a target to identify the target in the plate layout and
analysis plots.

In the software, an editable collection of targets to use in experiments. Targets in the
library contain the target name, reporter, quencher, and target color. The targets in the
library may also contain comments about the target.

In the software, the type of reaction performed in the well for the target. Available
tasks:
¢ Unknown

¢ Negative Control

In the software, the type of nucleic acid to add to the PCR reaction.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the instrument run.

See melting temperature (Tm).

In the software, the task for the target in wells that contain the sample being tested. In
HRM experiments, the task for the target in wells that contain a sample with an
unknown melt curve profile.

In an HRM experiment, a sample (or group of samples) with a unique melt curve (that
is, the melt curve is different from the melt curves of other samples or controls used in
the experiment). The software determines melt curve differences by the melting
temperature (Tm) and the shape of the melt curve.
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Numerics

3100/3100-Avant™ instrument sequencing run conditions
HRM methylation 78
HRM mutation scanning 62

3130/3130x/ instrument sequencing run conditions
HRM methylation 78
HRM mutation scanning 62

3500/3500x/ instrument sequencing run conditions
HRM methylation 78
HRM mutation scanning 62

3730/3730x! instrument sequencing run conditions
HRM mutation scanning 62

7500 Fast system
related documentation 105

A

Aligned Melt Curves
change calls 35
HRM general experiment 32
HRM genotyping 46
HRM methylation 73
HRM mutation scanning 57
omit outliers 34
publish data from 96
revert manual calls 35
troubleshooting, messy HRM curves 84
troubleshooting, multiple melt regions 83
troubleshooting, replicates widely spread 83
amplification of HRM calibration plate 11
amplification of HRM reactions
HRM general experiment 22
HRM genotyping 40
HRM methylation 67
HRM mutation scanning 52
Amplification Plot
HRM general experiment 23
HRM genotyping 41
HRM methylation 68
HRM mutation scanning 53
troubleshooting, amplification curve with low slope 81
troubleshooting, late amplification 80
troubleshooting, nonspecific amplification 82
troubleshooting, PCR inhibition 81
troubleshooting, some late amplification 80
analysis settings, specify

Index

HRM general experiment 29
HRM genotyping 44
HRM methylation 71
HRM mutation scanning 55

B

background calibration 10
biohazardous waste, handling 102
bisulfite treatment of samples (HRM methylation) 65

C

calibration
amplification of HRM calibration plate 11
background calibration 10
custom dye calibration 13
HRM calibration 14
calibration file. See HRM calibration file.
CAUTION, description 8
chemical safety 101
computer
configuration requirement 97
HRM Software requirements 94
technical support for altered configuration 97
controls, select for HRM experiment
HRM general experiment 18
HRM genotyping 38
HRM methylation 64
HRM mutation scanning 50
controls, set up in HRM Software
assign in HRM Software 27
control names 44, 55, 71
examples in HRM genotyping 44
examples in HRM methylation 71
examples in HRM mutation scanning 55
controls, set up in run file 22
copy and paste a plot 96
copy and paste HRM data 96
custom dye calibration 13
custom primers, ordering 92

D

DANGER, description 8
data, amplification
review for HRM general experiment 23
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Index

review for HRM genotyping 41

review for HRM methylation 68

review for HRM mutation scanning 53
data, high resolution melting

publish 96

review for HRM general experiment 25

review for HRM genotyping 43

review for HRM methylation 70

review for HRM mutation scanning 54
data, melt curve (system software)

review for HRM general experiment 24

review for HRM genotyping 42

review for HRM methylation 69

review for HRM mutation scanning 54
default HRM calibration file, changing 95
Derivative Melt Curves

about pre- and post-melt regions 29

adjust pre- and post-melt regions 30

omit outilers 34

publish data from 96

troubleshooting, messy HRM curves 84

troubleshooting, multiple melt regions 83

troubleshooting, replicates widely spread 83
Difference Plot

change calls 35

HRM general experiment 33

HRM genotyping 47

HRM methylation 73

HRM mutation scanning 58

omit outliers 34

publish data from 96

revert manual calls 35

troubleshooting, messy HRM curves 84

troubleshooting, multiple melt regions 83

troubleshooting, replicates widely spread 83
Dissociation Curve (system software)

HRM general experiment example 24

HRM genotyping example 42

HRM methylation example 69

HRM mutation scanning example 54
DNA templates, preparation of 91
documentation, related 105
dyes for HRM, about 89

E

edit parameters
set pre- and post-melt regions 30

examples (HRM Software)

controls in HRM genotyping 44

controls in HRM methylation 71

controls in HRM mutation scanning 55

Difference Plot for HRM general experiment 33

Difference Plot for HRM genotyping 47

Difference Plot for HRM methylation 74

Difference Plot for HRM mutation scanning 58

HRM general experiment files 26

HRM genotyping experiment files 43

HRM methylation experiment files 70

HRM mutation scanning experiment files 54
examples (system software)

Amplification Plot for HRM genotyping 41

Amplification Plot for HRM methylation 68

Amplification Plot for HRM mutation scanning 53

Dissociation Curve for HRM general experiment 24

Dissociation Curve for HRM genotyping 42

Dissociation Curve for HRM methylation 69

Dissociation Curve for HRM mutation scanning 54

Melt Curve for HRM general experiment 24

Melt Curve for HRM genotyping 42

Melt Curve for HRM methylation 69

Melt Curve for HRM mutation scanning 54

F

file name conventions
HRM calibration run file 15
HRM experiment file 30

G

general HRM experiments. See HRM general experiments.

genotyping experiments. See HRM genotyping.
guidelines
chemical safety 101

H

HRM calibration 14
when to perform 9

HRM calibration file
about 25
change 95
requirements 27
view 95

HRM calibration plate
prepare before amplification 11
prepare your own 90

HRM dyes, about 89

Aligned Melt Curves for HRM general experiment 33 HRM experiment file

Aligned Melt Curves for HRM genotyping 47 change the default HRM calibration file 95
Aligned Melt Curves for HRM methylation 73 edit 95

Aligned Melt Curves for HRM mutation scanning 58 overwrite the HRM calibration file 95
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HRM general experiment
Aligned Melt Curves 32
Amplification Plot 23
controls to include 18
Diftference Plot 33
Dissociation Curve 24
Melt Curve 24
primer design guidelines 17
workflow 17

HRM genotyping
Aligned Melt Curves 46
Amplification Plot 41
controls to include 38
Difference Plot 47
Dissociation Curve 42
Melt Curve 42
primer design guidelines 37
reaction component volumes 39
run file settings 40
thermal profile 40
workflow 37

HRM methylation
Aligned Melt Curves 73
Amplification Plot 68
amplify and melt the DNA 67
bisulfite treatment of samples 65
controls to include 64
Difference Plot 73
Dissociation Curve 69
Melt Curve 69
methylated DNA standards, prepare 65
primer design guidelines 64
reaction component volumes 66
run file settings 67
sequence the variants 75
thermal profile 67
workflow 63

HRM mutation scanning
Aligned Melt Curves 57
Amplification Plot 53
controls to include 50
Difference Plot 58
Dissociation Curve 54
Melt Curve 54
primer design guidelines 49
reaction component volumes 51
run file settings 52
sequence the variants 60
thermal profile 52
workflow 49

HRM Software
access the Help system 25
assay, definition of 96

Index

assign controls 27

change calls 35

change the HRM calibration file 95
computer requirements 94

create HRM experiment 26

edit an HRM experiment 95

example HRM general experiments 26
example HRM genotyping experiments 43
example HRM methylation studies 70
example HRM mutation scanning 54
omit outliers 34

publish data 96

revert manual calls 35

start the software 25

image file, save HRM plot as 96
IMPORTANT, description 8

M

M13 tail sequences 50
manual calls, revert to Auto call 35
Melt Curve (system software)

HRM general experiment example 24

HRM genotyping example 42

HRM methylation example 69

HRM mutation scanning example 54
MeltDoctor™ HRM Reagents

reaction component volumes using 93
melting profiles (HRM Software)

HRM general experiment 28

HRM genotyping 46

HRM methylation 72

HRM mutation scanning 57

troubleshooting, messy HRM curves 84

troubleshooting, multiple melt regions 83

troubleshooting, replicates widely spread 83
methylated DNA standards

bisulfite treatment 65

prepare 65
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